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1   Introduction
JFormDesigner is a professional  for Java Swing user interfaces. Its outstanding support for GUI designer

, , GroupLayout ( ), TableLayout and GridBagLayout makes it easy to MigLayout JGoodies FormLayout Free Design
.create professional looking forms

Why use JFormDesigner?

JFormDesigner makes Swing GUI design a real pleasure. It  you spend on  forms, decreases the time hand coding
giving you  to focus on the . You'll find that JFormDesigner  in more time real tasks quickly pays back its cost
improved  and increased . Even non-programmers can use it, which makes it GUI quality developer productivity
also ideal for .prototyping

Editions

JFormDesigner is available in four editions: as  application and as IDE plug-ins for , stand-alone Eclipse IntelliJ IDEA
and . This documentation covers all editions.NetBeans

If there are functional differences between the editions, then they are marked with: , , Stand-alone Eclipse plug-in
,  or .IntelliJ IDEA plug-in NetBeans plug-in IDE plug-ins

Key features

Easy and intuitive to use, powerful and productive

IDE plug-ins and stand-alone application

MigLayout support

GroupLayout (Free Design) support

JGoodies FormLayout and  supportTableLayout

Advanced  supportGridBagLayout

Column and row headers

Localization support

Beans Binding (JSR 295) support

BeanInfo Annotations

Java code generator or runtime library

Generation of nested classes
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2   User Interface
This is the main window of JFormDesigner  edition:stand-alone

The main window consists of the following areas:

Main Menu: Located at the top of the window.

Toolbar: Located below the main menu.

Palette: Located at the left side of the window.

Design View: Located at the center of the window.

Structure View: Located at the upper right of the window.

Properties View: Located at the lower right of the window.

Bindings View: Located below the Design view. This view is not visible by default. Click the Show Bindings 

 button ( ) in the toolbar to make is visible.View

Error Log View: Located below the Design view. This view is not visible in the above screenshot.
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2.1   Menus

You can invoke most commands from the main menu (at the top of the main frame) and the various context (right-
click) menus.

Main Menu

The main menu is displayed at the top of the JFormDesigner main window of the  edition.stand-alone

File menu

New Project Creates a new project.

Open Project Opens an existing project.

Reopen Project Displays a submenu of previously opened projects. Select a project to open it.

Project Properties Displays the project properties.

Close Project Closes the active project.

New Form Creates a new form.

Open Form Opens an existing form.

Reopen Form Displays a submenu of previously opened forms. Select a form to open it.

Close Closes the active form.

Close All Closes all open forms.

Save Saves the active form and generates the Java source code for the form (if Java Code Generation is 
enabled in the ).Preferences

Save As Saves the active form under another file name or location and generates the Java source code for 
the form (if Java Code Generation is enabled in the ).Preferences

Save All Saves all open forms and generates the Java source code for the forms (if Java Code Generation 
is enabled in the ).Preferences

Import Imports NetBeans or IntelliJ IDEA form files and creates new JFormDesigner forms. Use File > 
 to save the new form in the same folder as the original form file. This also updates the .java Save

file.

Exit Exits JFormDesigner. : this item is in the JFormDesigner application menu.Mac

 

Edit menu

Undo Reverses your most recent editing action.

Redo Re-applies the editing action that has most recently been reversed by the Undo action.

Cut Cuts the selected components to the clipboard.

Copy Copies the selected components to the clipboard.

Paste Pastes the components in the clipboard to the selected container of the active form.

Rename Renames the selected component.

Delete Deletes the selected components.

 

View menu

Refresh Designer Refresh the  view of the active form. Reloads all classes used by the form and recreates Design
the form preview shown in the  view. You can use this command, if you changed the code Design
of a component used in the form to reload the component classes. But usually this is not 
necessary because JFormDesigner automatically reloads component classes.

Classic Layout Shows  view below  view.Properties Structure

Wide Layout Shows  and  views side by side.Properties Structure
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Form menu

Test Form Tests the active form. Creates live instances of the form in a new window. You can close that 
window by pressing the  key when the window has the focus. If your form contains more Esc
than one top-level component, use the drop-down menu in the toolbar to test another 
component.

Localize Edit  settings, resource bundle strings, create new locales or delete locales.localization

New Locale Creates a new locale.

Delete Locale Deletes an existing locale.

Externalize Strings Moves strings to a resource bundle for localization. Use this command to start localizing existing 
forms.

Internalize Strings Moves strings from a resource bundle into the form and remove the strings from the resource 
bundle.

Generate Java Code Generates the Java code for the active form. Usually it's not necessary to use this command 
because when you save a form, the Java code will be also generated.

 

Window menu

Activate Designer Activates the  view.Design

Activate Structure Activates the  view.Structure

Activate Properties Activates the  view.Properties

Activate Bindings Activates the  view. By default, the Bindings view is not visible.Bindings

Activate Error Log Activates the  view. By default, the Error Log view is not visible. It automatically appears Error Log
if an error occurs.

Next Form Activates the next form.

Previous Form Activates the previous form.

Preferences Opens the  dialog. : this item is in the JFormDesigner application menu.Preferences Mac

 

Help menu

Help Contents Displays help topics.

Tip of the Day Displays a list of interesting productivity features.

Register Activates your license.

License Displays information about your license.

Check for Updates Checks whether a newer version of JFormDesigner is available.

About Displays information about JFormDesigner and the system properties. : this item is in the Mac
JFormDesigner application menu.

Context menus

Context menus appear when you're right-click on a particular component or control.

Design view context menu: Properties view context menu:
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2.2   Toolbars

Toolbars provide shortcuts to often used commands.

Main Toolbar

This is the toolbar of JFormDesigner  edition. Many of the commands are also used in the toolbars of stand-alone
the .IDE plug-ins

New Project Creates a new project.

Open Project Opens an existing project.

Project Properties Displays the project properties.

New Form Creates a new form.

Open Form Opens an existing form.

Save Saves the active form and generates the Java source code for the form (if Java Code Generation 
is enabled in the ).Preferences

Save All Saves all open forms and generates the Java source code for the forms (if Java Code Generation 
is enabled in the ).Preferences

Undo Reverses your most recent editing action.

Redo Re-applies the editing action that has most recently been reversed by the Undo action.

Cut Cuts the selected components to the clipboard.

Copy Copies the selected components to the clipboard.

Paste Pastes the components in the clipboard to the selected container of the active form.

Delete Deletes the selected components.

Test Form Tests the active form. Creates live instances of the form in a new window. You can close that 
window by pressing the  key when the window has the focus. If your form contains more Esc
than one top-level component, use the drop-down menu to test another component.

Allows you to change the look and feel of the components in the  view.Design

Refresh Designer Refresh the  view of the active form. Reloads all classes used by the form and recreates Design
the form preview shown in the  view. You can use this command, if you changed the Design
code of a component used in the form to reload the component classes. But usually this is not 
necessary because JFormDesigner automatically reloads component classes.

Allows you to change the locale of the form in the  view. "(no locale)" is show if the form Design
is not localized. Use  to start localizing a form.Form > Externalize Strings

Localize Edit  settings, resource bundle strings, create new locales or delete locales.localization

Show Bindings View Shows the  view.Bindings

Generate Java Code Generates the Java code for the active form. Usually it's not necessary to use this command 
because when you save a form, the Java code will be also generated.

Help Contents Displays help topics.

Classic Layout Shows  view below  view.Properties Structure

Wide Layout Shows  and  views side by side.Properties Structure
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2.3   Design View

This view is the central part of JFormDesigner. It displays the opened forms and lets you edit forms.

Stand-alone: At top of the view, tabs are displayed for each open form. Click on a tab to activate a form. To close a 

form, click the  symbol that appears on the right side of a tab if the mouse is over it. An asterisk (*) in front of 
the form name indicates that the form has been changed.

IDE plug-ins: The Design view is integrated into the IDEs, which have its own tabs.

On the top and left sides of the view, you can see the column and row . These are important controls for headers
grid-based layout managers. Use them to insert, delete or move columns/rows and change column/row properties.

In the center is the design area. It displays the form, grids and handles. You can drag and drop components, 
resize, rename, delete components or in-place-edit labels.

Selecting components

To select a single component, click on it. To select multiple components, hold down the  ( : ) or Ctrl Mac Command
 key and click on the components. To select the parent of a selected component, hold down the  key ( : Shift Alt Mac

 key) and click on the selected component.Option

To select components in a rectangular area, select  in the  and click-and-drag a Marquee Selection Palette
rectangular selection area in the Design view. Or click-and-drag on the free area in the Design view. All 
components that lie partially within the selection rectangle are selected.

The selection in the Design view and in the  view is synchronized both ways.Structure

Drag feedback

JFormDesigner provides four types of drag feedback.

The  figure shows the outline of the dragged components. It always follows the mouse location. The  gray green
figure indicates the drop location, the  figure indicates a new column/row and  figures indicate occupied yellow red
areas.
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Cursor feedback

JFormDesigner uses various cursors while dragging components:

The dragged components will be moved to the new location.

Either add a new component to the form or copy existing components.

Add multiple components of the same type to the form.

It is not possible to drop the component at this location.

Add components

To add components, choose a component from the  and drop it to the location where you want to add it.Palette

To add multiple instances of a component, hold down the  key ( :  key) while clicking on the Ctrl Mac Command
Design view.

Move or copy components

To move components simply drag them to the new location. You will get reasonable visual feedback during the 
drag operation.

To copy components, proceed just as moving components, but hold down the  key ( :  key) before Ctrl Mac Option
dropping the components.

You can cancel all drag operations using the  key.Esc

Resize components

Use the selection handles to resize components. Click on a handle and drag it.

The green feedback figure indicates the new size of the component. The tool tip provides additional information 
about location, size and differences.

Whether a component is resizable or not depends on the used .layout manager

Morph components

The "Morph Bean" command allows you to change the class of existing components without loosing properties, 
events or layout information. Right-click on a component in the  or  view and select  Design Structure Morph Bean
from the popup menu.

Nest in Container

The "Nest in Container" command allows you to nest selected components in a new container (usually a JPanel). 
Right-click on a component in the  or  view and select  from the popup menu. The Design Structure Nest in JPanel
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new container gets the same  as the old container and is placed at the same location where the layout manager
selected components were located. For grid-based layout managers, the new container gets columns and rows 
and the  of the selected components are preserved.layout constraints

   

Non-visual beans

To add a non-visual bean to a form, select it in the  (or use ) and drop it into the free area of Palette Choose Bean
the Design view. Non-visual beans are shown in the Design view using proxy components.

Red beans

If a bean could not be instantiated (class not found, exception in constructor, etc), a  will be shown in the red bean
designer view as placeholder.

   

To fix such problems, take a look at the  view and if necessary add required jars to the  of your Error Log classpath
project.

2.3.1   Headers

The column and row headers (for grid-based layout managers) show the structure of the layout. This includes 
column/row indices, alignment, growing and grouping.

Use them to insert, delete or move columns/rows and change column/row properties. Right-clicking on a column
/row displays a popup menu. Double-clicking shows a dialog that allows you to edit the column/row properties.

If a column width or row height is zero, which is the case if a column/row is empty, then 
JFormDesigner uses a minimum column width and row height. Columns/rows having a 
minimum size are marked with a light-red background in the column/row header.

Selecting columns/rows

You can select more than one column/row. Hold down the  key ( :  key) and click on another Ctrl Mac Command
column/row to add it to the selection. Hold down the  key to select the columns/rows between the last Shift
selected and the clicked column/row.
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Insert column/row

Right-click on the column/row where you want to insert a new one and select  /  from Insert Column Insert Row
the popup menu. The new column/row will be inserted  the right-clicked column/row. To add a column/row before

 the last one, right-click on the area behind the last column/row.after

If the layout manager is , an additional gap column/row will be added. Hold down the  key before FormLayout Shift
selecting the command from the popup menu to avoid this.

Besides using the popup menu, you can insert new columns/row when dropping components on column/row 
gaps or outside of the existing grid. In the first figure, a new row will be inserted between existing rows. In the 
second figure, a virtual grid is shown below/right to the existing grid and a new row will be added.

   

Delete columns/rows

Right-click on the column/row that you want delete and select  /  from the popup Delete Column Delete Row
menu.

If the layout manager is , an existing gap column/row beside the removed column/row will also be FormLayout
removed. Hold down the  key before selecting the command from the popup menu to avoid this.Shift

Split columns/rows

Right-click on the column/row that you want split and select  /  from the popup menu.Split Column Split Row

If the layout manager is , an additional gap column/row will be added. Hold down the  key before FormLayout Shift
selecting the command from the popup menu to avoid this.

Move columns/rows

The headers allow you to drag and drop columns/rows (incl. contained components and gaps). This allows you to 
swap columns or move rows in seconds. Click on a column or row and drag it to the new location. JFormDesigner 
updates the column/row specification and the locations of the moved components.

If the layout manager is , then existing gap columns/rows are also moved. Hold down the  key FormLayout Shift
before dropping a column/row to avoid this.
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Resize columns/rows

To change the (minimum) size of a column/row, click near the right edge of a column/row and drag it.

FormLayout supports minimum and constant column/row sizes. Hold down the  key to change the minimum Ctrl
size.  supports only constant sizes and  supports only minimum sizes.TableLayout GridBagLayout

Header symbols

Following symbols are used in the headers:

Column Header

Left aligns components in the column.

Center components in the column.

Right aligns components in the column.

Fill (expand) components into the column.

Left or right aligns components in the column depending on container's orientation (left-to-right or right-to-left).

Right or left aligns components in the column depending on container's orientation (left-to-right or right-to-left).

Aligns components (usually labels) to left, center or right depending on platform style guide. E.g. right align on Mac and 
left align on other platforms.

Grow column width.

 

Row Header

Top aligns components in the row.

Center components in the row.

Bottom aligns components in the row.

Fill (expand) components into the row.

Baseline aligns components in the row.

Aligns components above baseline in the row.

Aligns components below baseline in the row.

Grow row height.

2.3.2   In-place-editing

In-place-editing allows you to edit the text of labels and other components directly in the  view. Simply Design
select a component and start typing. JFormDesigner automatically displays a text field that allows you to edit the 
text.

You can also use the  key or double-click on a component to start in-place-editing. Confirm your changes Space
using the  key, or cancel editing using the  key.Enter Esc

Ctrl+double-click  opens dialog to edit text property.
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In-place-editing is available for all components, which support one of the properties ,  textWithMnemonic text

or .title

In-place-editing is also supported for the title of  and the tab titles of .TitledBorder JTabbedPane

TitledBorder : double-click on the title of the ; or select the component with the TitledBorder TitledBorder

and start in-place-editing as usual.

JTabbedPane : double-click on the tab title; or single-click on the tab, whose title you want to edit and start in-
place-editing as usual.

2.3.3   Keyboard Navigation

Keyboard navigation allows you to change the selection in the designer view using the keyboard. This allows you 
for example to edit a bunch of labels using  without having to use the mouse. You can use the in-place-editing
following keys:

Key Description

Up move the selection up

Down move the selection down

Left move the selection left

Right move the selection right

Home select the first component

End select the last component

Note: Keyboard navigation is currently limited to one container. You cannot move the selection to another 
container using the keyboard.

2.3.4   Menu Designer

The menu designer makes it easy to create and modify menu bars and popup menus. It supports in-place-editing 
menu texts and drag-and-drop menu items.

Menu bar structure

This figure shows the structure of a menu bar. The horizontal bar on 
top of the image is a  that contains  components. The JMenuBar JMenu

 contains , , JMenu JMenuItem JCheckBoxMenuItem

 or Menu Separator components. To create a JRadioButtonMenuItem

sub-menu, put a  into a .JMenu JMenu

The component  provides a category "Menus" that contains all components necessary to create menus.palette
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1.  

2.  

3.  

1.  

2.  

Creating menu bars

To create a menu bar:

add a  to a JMenuBar JFrame

add  to the  andJMenus JMenuBar

add  to the JMenuItems JMenus

Select the necessary components in the  and drop them to the  view.Palette Design

You can freely drag and drop the various menu components to rearrange them.

Creating popup menus

To create a popup menu:

add a  to the free area in the  view andJPopupMenu Design

add  to the JMenuItems JPopupMenu

Assign popup menus to components

You can assign a popup menu to a component in the properties view using the "componentPopupMenu" 
property. Select the component to which you want attach the popup menu and assign it in the  view. Properties
Note that you must expand the  category to see the property. Or use search as in the Expert Properties
screenshot below.
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2.3.5   Column/Row Groups

Column and row groups (  and  only) are used to specify that a set of columns or rows will MigLayout FormLayout
get the same width or height. This is an essential feature for symmetric, and more generally, balanced design.

In the above example, columns [0 and 2] and columns [1 and 3] have the same width.

To visualize the grouping, JFormDesigner displays lines connecting the grouped columns/rows near to the column 
and row .headers

Group columns/rows

To create a new group,  the columns/rows you want to group in the , right-click on a selected columnselect header
/row in the header and select  from the popup menu.Group

Note that selected gap columns/rows will be ignored when grouping (  only).FormLayout

You can extend existing groups by selecting at least one column/row of the existing group and the columns/rows 
that you want to add to that group, then right-click on a selected column/row and select  from the popup Group
menu.

Ungroup columns/lines

To remove a group,  all columns/rows of the group, right-click on a selected column/row and select  select Ungroup
from the popup menu.

To remove a single column/row from a group, right-click on it and select  from the popup menu.Ungroup

Group IDs

A unique group ID identifies each group. When using the header context menu to group/ungroup, you don't have 
to care about those IDs. JFormDesigner manages the group IDs automatically.

However, it is possible to edit the group ID in the  or  Column/row properties dialog.MigLayout FormLayout
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2.3.6   Button Groups

Button groups ( ) are used in combination with radio buttons to ensure that only one javax.swing.ButtonGroup

radio button in a group of radio buttons is selected.

To visualize the grouping, JFormDesigner displays lines connecting the grouped buttons.

Group Buttons

To create a new button group, select the buttons you want to group, right-click on a selected button and select 
 from the popup menu.Group Buttons

You can extend existing button groups by selecting at least one button of the existing group and the buttons that 
you want to add to that group, then right-click on a selected button and select  from the popup Group Buttons
menu.

Note that the  and  commands are only available in the context menu if the Group Buttons Ungroup Buttons
selection contains only components that are derived from  (  and ).JToggleButton JRadioButton JCheckBox

Ungroup Buttons

To remove a button group, select all buttons of the group, right-click on a selected button and select Ungroup 
 from the popup menu.Buttons

To remove a button from a group, right-click on it and select  from the popup menu.Ungroup Buttons

ButtonGroup object

Button groups are . They appear at the bottom of the  view and in the  view. non-visual beans Structure Design
JFormDesigner automatically creates and removes those objects. You can rename button group objects.
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If a grouped button is selected, you can see the association to the button group in the  view.Properties

2.3.7   JTabbedPane

JTabbedPane is a container component that lets the user switch between pages by clicking on a tab.

After adding a JTabbedPane to your form, it looks like this one:

To add pages, select an appropriate component (e.g. JPanel) in the palette, move the cursor over the tabs area of 
the JTabbedPane and click to add it.

   

You can see only the components of the active tab. Click on a tab to switch to another page. To change a tab title, 
double-click on a tab to  it. You can edit other tab properties (tool tip text, icon, ...) in the  in-place-edit Properties
view. Select a page component (e.g. JPanel) to see its tab properties.

To change the tab order, select a page component (e.g. JPanel) and drag it over the tabs to a new place. You can 
also drag and drop page components in the  view to change its order.Structure
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Use an empty border to separate the page contents from the JTabbedPane border. If you are using MigLayout, it's 
recommended to use . For JGoodies Forms use border . Otherwise, use an Layout Insets TABBED_DIALOG

.EmptyBorder

   

2.3.8   Events

Components can provide events to signal when activity occurs (e.g. button pressed or mouse moved). 
JFormDesigner shows events in the  category in the  view.Events Properties

IDE plug-ins: Click on the  button ( ) to go to the event handler method in the Java editor of the Go to Method
IDE.

Add Event Handlers

To add an event handler to a component, right-click on the component in the  or  view and select Design Structure

 from the popup menu. Or click the  button ( ) in the  view. The events Add Event Handler Add Event Properties
popup menu lists all available event listeners for the selected components and is divided into three sections: 
preferred, normal and expert event listeners.

The  icon in the popup menu indicates that the listener interface will be implemented (e.g. javax.swing.

ChangeListener). The  icon indicates that the listener adapter class will be used (e.g. java.awt.event.

FocusAdapter for java.awt.event.FocusListener). The icons  and  are used when the listener is already 
implemented.
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After selecting an event listener from the popup menu, you can specify the name of the handler method and 
whether listener methods should be passed to the handler method in following dialog.

If you add a , you PropertyChangeListener

can also specify a property name (field is not 
visible in screenshot). Then the listener is added 
using the method 
addPropertyChangeListener(String 

propertyName, PropertyChangeListener 

.listener)

The "Go to handler method in Java editor" check 
box is only available in the .IDE plug-ins

Stand-alone: After saving the form, go to your favorite IDE and implement the body of the generated event 
handler method.

If you use the  and the Java code generator is disabled, you must implement the handler method Runtime Library
yourself in the target class. See documentation of method  in the JFormDesigner FormCreator.setTarget()

Loader API for details.

Remove Event Handlers

To remove an event handler, click the  button ( ). Or right-click on the event and select Remove Event Remove 
 from the popup menu.Event

Change Handler Method Name

You can either edit the method name directly in the property table or click the ellipsis button ( ) to open the Edit 
 dialog where you can edit all event options.Event Handler
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2.4   Palette

The component palette provides quick access to commonly used components ( ) available for adding to JavaBeans
forms.

The components are organized in categories. Click on a category header to expand or 
collapse a category.

You can add a new component to the form in following ways:

Select a component in the palette, move the cursor to the  or  view Design Structure
and click where you want to add the component.

Select , enter the class name of the component in the  Choose Bean Choose Bean
dialog, click OK, move the cursor to the  or  view and click where you Design Structure
want to add the component.

To add multiple instances of a component, hold down the  key ( :  key) Ctrl Mac Command
while clicking on the  or  view.Design Structure

The component palette is fully customizable. Right-click on the palette to add, edit, remove 
or reorder components and categories. Or use the .Palette Manager

Toolbar commands

Palette Manager Opens the  dialog to customize the palette.Palette Manager

Palette Manager

This dialog allows you to fully customize the component palette. You can add, edit, remove or reorder 
components and categories.
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Choose Bean

You can use any component that follows the  specification in JFormDesigner. Select  in the JavaBean Choose Bean
palette to open the Choose Bean dialog.

Here you can search for classes. Enter the first few characters of the class you want to choose until it appears in 
the matching classes list. Then select it in the list and click OK.

Following pattern kinds are supported:

Wildcards:  for any string;  for any character; terminating  or  (space) prevents implicit trailing "*""*" "?" "<" " "

Camel case:  for classes containing  and  as upper-case letters in camel-case notation, e.g.  "JB" "J" "B" JButton

or ;  for classes containing  and  as parts in camel-case notation, e.g. JideButton "DaPi" "Da" "Pi" DatePicker

The matching classes list displays all classes that match. It is separated into up to three sections:

History matches: classes found in the history of last used classes. If the search field is empty, the complete 
history is displayed. To delete a class from the history, select it and press the  key or right-click on it Delete
and select  from the popup menu.Delete

Project matches: classes found in the Classpath specified in the current .Project

Palette matches: classes found in the palette.

Filter Menu Options

Use Filter Classes are hidden if they do not match the filter. E.g. if the JavaBean filter is active and the class is 
not public or does not have a public constructor.

Show Interfaces Includes interfaces in the list of matching classes.

The  check box allows you to specify whether a bean is a container or not.Is Container

If you select , the component will be added to the palette category specified in the Add to palette category
following field. Click the  button to create a new category for your components if necessary.New

Stand-alone: Use the  button to specify the location of your component classes. Add your JAR files or Classpath
class folders.

IDE plug-ins: The classpath specified in the IDE project is used to locate component classes.
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2.5   Structure View

This view displays the hierarchical structure of the components in a form.

Each component is shown in the tree with an icon, its name and 
additional information like layout manager class or the text of a label or 
button. The name must be unique within the form and is used as 
variable name in the generated Java code.

You can edit the name of the selected component in the tree by 
pressing the  key. Right-click on a component to invoke commands F2
from the context menu.

The selection in the Structure view and in the  view is Design
synchronized both ways.

The tree supports multiple selection. Use the  key ( :  key) to add individual selections. Use the Ctrl Mac Command
 key to add contiguous selections.Shift

The tree supports drag and drop to rearrange components. You can also add new components from the  to palette
the Structure view. Besides the feedback indicator in the structure tree, JFormDesigner also displays a green 
feedback figure in the  view to show the new location.Design

Various overlay icons are used in the tree to indicate additional information:

The component is bound to a Java class. Each component can have its own (nested) class. See  for Nested Classes
details.

The component has  assigned to it. The bindings are shown in  view and in the  category in bindings Bindings Bindings
the  view.Properties

The component has  assigned to it. The events are shown in the  category in the  view.events Events Properties

The component has custom code assigned to it. See  properties.Code Generation

The variable modifier of the component is set to . See  properties.public Code Generation

The variable modifier of the component is set to .default

The variable modifier of the component is set to .protected

The variable modifier of the component is set to .private

A property (e.g. ) of the component has a reference to a non-existing component. This can happen JLabel.labelFor

if you e.g. remove a referenced . In the above screenshot, the component  has an invalid JTextField phoneLabel

reference.

Toolbar commands

Expand All Expand all nodes in the structure tree.

Collapse All Collapse all nodes in the structure tree.
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2.6   Properties View

The Properties view displays and lets you edit the properties of the selected component(s). Select one or more 
components in the  or  view to see its properties. If more than one component is selected, only Design Structure
properties that are available in all selected components are shown.

The properties table displays the component name, component class, layout  and  properties, manager constraints
, , , component properties and  properties. The list of component bindings events client properties code generation

properties comes from introspection of the component class (JavaBeans).

Properties are organized in categories, which you can expand/collapse 
by clicking on the category name or on the small arrow icons. The 
number of properties in a category and the number of set properties is 
displayed near the category name.

The category names of component property categories (Properties, 
Expert Properties, etc) are displayed in blue color.

Different font styles are used for the property names. Bold style is used 
for preferred (often used) properties, plain style for normal properties 
and italic style for expert properties. Read-only properties are shown 
using a gray font color.

The white background indicates unset properties. The shown values are 
the default values of the component. The light green background 
indicates set properties. Java code will be generated for set properties 

only. Use  ( ) to unset a property. Use Restore Default Value Set 
 from the popup menu to set a property explicitly to .Value to null null

A small arrow ( ) near the property name indicates that the property is 
.bound

Use  ( ) to organize component properties into three predefined categories (normal, expert Group by Category

and read-only) and  (defined in ).  ( ) organizes component custom categories BeanInfo Group by Defining Type
properties into defining types (e.g. JTextField, JTextComponent, JComponent, Container, Component). Alphabetical

( ) shows all component properties in one category.

Changing property values

The left column displays the property names, the right column the property values. Click on a property value to 
edit it.

You can either edit a value directly in the property table or use a custom property editor by clicking on the ellipsis 

button ( ) on the right side or pressing the  key. The custom editor pops up in a new dialog. The flag button (F3
), which is only available for localized forms and string properties, allows you to choose existing strings from the 
resource bundle of the form.

The type of the editor depends on the data type of the property. JFormDesigner has built-in  for all property editors
standard data types.



JFormDesigner 8.3 Documentation

- 23 -

For numbers, a spinner editor makes it easier to increase or decrease the value using the arrow buttons or  Up
and  keys. Press the  key to confirm the change; or the  key to cancel it.Down Enter Esc

Search for property names

To filter the list of shown properties, select the  ( ) toolbar button. This shows a text field below the Show Filter
toolbar, where you can enter your filter criteria. Use space, comma or semicolon as separator for multiple 
property names.

Common properties and categories

Property/Category Description

Name The name of the component. Must be unique within the form. Used as variable name in the 
generated Java code. It is also possible to specify a different variable name in the  Code Generation
category.

Class The class name of the component. The tooltip displays the full class name and the class hierarchy. 
Click on the value to morph the component class to another class (e.g. JTextField to JTextArea).

Button Group The name of the button group assigned to the component. This property is only visible for 
components derived from  (e.g.  and ).JToggleButton JRadioButton JCheckBox

Layout Manager Layout manager properties of the container component. The list of layout properties depends on the 
used layout manager. This property is only visible for container components. Click on the value to 

.change the layout manager

Layout Constraints Layout constraints properties of the component. The list of constraints properties depends on the 
layout manager of the parent component. This property is only visible if the layout manager of the 
parent component uses constraints.

Bindings Bindings of the component.

Events Events of the component.

Client Properties Client properties of the component. This property is only visible if there are client properties defined 
in the  preferences.Client Properties

Code Generation Code Generation properties of the component.

"(form)" properties

Select the "(form)" node in the  view to modify special form properties:Structure

Property Name Description

Form file format The format used to persist the form. See also "Form file format" option in  preferences.General

Set Component Names If , invokes java.awt.Component.setName() on all components of the form.true
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2.6.1   Layout Manager Properties

Each container component that has a  has layout properties. The list of layout properties depends layout manager
on the used layout manager.

Select a  in the  or  view to see its layout properties in the  view.container component Design Structure Properties

This screenshot shows layout manager properties of a container that has a MigLayout.

When you add a container component to a form, following dialog appears and you can choose the layout manager 
for the new container. You can also set the layout properties in this dialog.

2.6.2   Layout Constraints Properties

Layout Constraints properties are related to layout managers. Some layout managers (MigLayout, FormLayout, 
TableLayout, GridBagLayout, ...) use constraints to associate layout information (e.g. grid x/y) to the child 

 of a container.components

The list of constraints properties depends on the layout manager of the parent component.
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Select a component in the  or  view to see its constraints properties in the  view.Design Structure Properties

This screenshot shows constraints properties of a component in a MigLayout.

2.6.3   Client Properties

What is a client property?

Swings base class for all components, , provides following methods that allows you to javax.swing.JComponent

set and get user-defined properties:

public  Object getClientProperty(Object key);final

   putClientProperty(Object key, Object value);public final void

Some Swing components use client properties to change their behavior. E.g. for JLabel you can disable HTML 
display with  You can use client properties label.putClientProperty("html.disable", Boolean.TRUE);

to store any information in components. Visit  on Ben Galbraith's Blog for a Finally... Client Properties You Can Use
use case.

Define client properties

You can define client properties on the  page in the  dialog.Client Properties Preferences

Edit client properties

If you've defined client properties, JFormDesigner shows them in the  view, where you can set the values Properties
of the client properties.

https://blog.bengalbraith.com/2006/04/13/finally-client-properties-you-can-use/
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2.6.4   Code Generation Properties

This category contains properties related to the Java code generator.

Component

Property Name Description

Nested Class Name The name of the generated nested Java class. See  for details.Nested Classes

Variable Name The variable name of the component used in the generated Java code. By default, it is equal to the 
component name.

Variable Modifiers The modifiers of the variable generated for the component. Allowed modifiers: , , public default

, ,  and . Default is .protected private static transient private

Use Local Variable If , the variable is declared as local in the initialization method. Otherwise, at class level. Default true

is .false

Gen. Getter Method If , generate a public getter method for the component. Default is .true false

Variable Annotations Annotations of component variable.

Type Parameters Parameters of component type. E.g. .MyTypedBean<String>

Custom Create If , create component in createUIComponents() method. Useful if you want use component true

factories for or non-default constructors. JFormDesigner generates the createUIComponents() 
method, but no component instantiation code. It is your responsibility to add code to 
createUIComponents().

Custom Creation Code Custom code for creation of the component.

Pre-Creation Code Code included before creation of the component.

Post-Creation Code Code included after creation of the component.

Pre-Initialization Code Code included before initialization of the component.

Post-Initialization Code Code included after initialization of the component.
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"(form)" properties

Select the "(form)" node in the  view to modify special form properties:Structure

Property Name Description

Generate Java Source 
Code

If true, generate Java source code for the form. Defaults to "Generate Java source code" option in the 
 preferences.Java Code Generator

Default Variable 
Modifiers

The default modifiers of the variables generated for components. Allowed modifiers: , public

, , ,  and . Default is .default protected private static transient private

Default Use Local 
Variable

If , the component variables are declared as local in the initialization method. Otherwise, at true

class level. Default is .false

Default Gen. Getter 
Method

If , generate public getter methods for components. Default is .true false

Default Event Handler 
Modifiers

The default modifiers used when generating event handler methods. Allowed modifiers: , public

, , ,  and . Default is .default protected private final static private

Member Variable Prefix Prefix used for component member variables. E.g. "m_".

Use 'this' for member 
variables

If enabled, the code generator inserts 'this.' before all member variables. E.g. this.nameLabel.
setText("Name:");

I18n Initialization 
Method

If enabled, the code generator puts the code to initialize the localized texts into a method 
initComponentsI18n(). You can invoke this method from your code to switch the locale of a form at 
runtime.

I18n 'getBundle' 
Template

Template used by code generator for getting a resource bundle. Default is ResourceBundle.
getBundle(${bundleName})

I18n 'getString' 
Template

Template used by code generator for getting a string from a resource bundle. Default is 
${bundle}.getString(${key})

I18n 'translate' 
Template

Template used by code generator to translate a string into another locale (e.g. i18n.tr(${value})
for Gettext Commons library).

I18n Key Constants 
Class

The name of a class that contains constants for resource keys.

Binding Initialization 
Method

If enabled, the code generator puts the code to create bindings into a method 
initComponentBindings().

MigLayout: API 
Constraints

If enabled, then MigLayout API is used to create constraints. Otherwise, strings are used.
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2.6.5   Property Editors

Property editors are used in the  view to edit property values.Properties

You can either edit a value directly in the property table or use a custom property editor by clicking on the ellipsis 

button ( ) on the right side. The custom editor pops up in a new dialog.

The type of the editor depends on the data type of the property. JFormDesigner has built-in property editors for all 
standard data types. Custom JavaBeans can provide their own property editors. Take a look at the API 
documentation of ,  and java.beans.PropertyEditor java.beans.PropertyDescriptor java.beans.

 and the  topic for details.BeanInfo JavaBeans

Built-in property editors

JFormDesigner has built-in property editors for following data types:

String, , , , , , , , , , , String[] boolean byte char double float int long short java.lang.Boolean

, , , , java.lang.Byte java.lang.Character java.lang.Class java.lang.Double java.lang.

, , , ,  and Float java.lang.Integer java.lang.Long java.lang.Short java.math.BigDecimal

java.math.BigInteger

ActionMap (javax.swing)

Border (javax.swing)

Color (java.awt)

ComboBoxModel (javax.swing)

Cursor (java.awt)

Dimension (java.awt)

Font (java.awt)

Icon (javax.swing)

Image (java.awt)

InputMap (javax.swing)

Insets (java.awt)

KeyStroke (javax.swing)

ListModel (javax.swing)

Object (java.lang)

Paint (java.awt)

Point (java.awt)

Rectangle (java.awt)

SpinnerModel (javax.swing)

TableModel (javax.swing)

TreeModel (javax.swing)
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ActionMap (javax.swing)

This (read-only) custom editor allows you to see the actions registered for a component in its action map. The 
information in the column "Key Stroke" comes from the input map of the component and shows which key strokes 
are assigned to actions. The JComponent property "actionMap" is read-only. Expand the  Read-only Properties
category in the  view to make it visible.Properties

Border (javax.swing)

You can either select a border from the combo box in the properties table or use the custom editor.

In the custom editor you can edit all border properties. Use the combo box at the top of the dialog to choose a 
border type. In the mid area of the dialog you can edit the border properties. This area is different for each border 
type. At the bottom, you can see a preview of the border.

Following border types are supported:

BevelBorder

CompoundBorder

DropShadowBorder  (SwingX)

EmptyBorder

EmptyBorder  (JGoodies)

EtchedBorder

LineBorder

MatteBorder

SoftBevelBorder

TitledBorder

Swing look and feel

custom borders
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Color (java.awt)

In the properties table, you can either enter RGB values, color names, system color names or Swing UIManager 
color names. When using an RGB value, you can also specify the alpha value by adding a fourth number.

The custom editor supports various ways to specify a color. Besides RGB, you can select a color from the AWT, 
System or Swing palettes.

ComboBoxModel (javax.swing)

This custom editor allows you to specify string values for a combo box.

Cursor (java.awt)

This editor allows you to choose a predefined cursor.
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Dimension (java.awt)

Either edit the dimension in the property table or use the custom editor.

Font (java.awt)

You can either use absolute fonts, derived fonts or predefined fonts of the look and feel. Derived fonts are 
recommended if you just need a bold/italic or a larger/smaller font (e.g. for titles), because derived fonts are 
computed based on the current look and feel. If your application runs on several look and feels (e.g. several 
operating systems), derived fonts ensure that the font family stays consistent.

In the properties table, you can quickly change the style (bold and italic) and the size of the font.

In the custom editor you can choose one of the tabs to specify either absolute fonts, derived fonts or predefined 
fonts.
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Icon (javax.swing) and Image (java.awt)

This custom editor allows you to choose an icon. It supports bitmap images (PNG, GIF and JPEG) and vector 
graphics (SVG). When using SVG, then class  from  is required.FlatSVGIcon FlatLaf Extras

Click the plus button in the properties table to open the default custom editor, which allows you to use an icon 
from the project resources.

For SVG icons you can optionally specify custom width, height and scale factor to change the icon size.

It is also possible to specify color mapping. All colors, or a single color, in SVG can be mapped to a new color. For 
dark FlatLaf themes, it is possible to specify another color.

https://github.com/JFormDesigner/FlatLaf/tree/main/flatlaf-extras
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Click the ellipsis button in the properties table to open the extended custom editor, which allows you to use an 
icon from the project resources, from the file system or from the Swing UIManager (look and feel). It is 
recommended to use the project resources and embed your icons into your application JAR.

Code templates  and  are used when generating Property: SVG Icon from resource Property: Icon from resource
Java code. See  preferences page.Templates (Java Code Generator)
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InputMap (javax.swing)

This (read-only) custom editor allows you to see the key strokes registered for a component in its input map. The 
information in the column "Action" comes from the action map of the component and shows which action classes 
are assigned to key strokes. The JComponent property "inputMap" is read-only. Expand the  Read-only Properties
category in the  view to make it visible.Properties

Insets (java.awt)

Either edit the insets in the property table or use the custom editor.

KeyStroke (javax.swing)

In the properties table, you can enter a string representation of the keystroke. E.g. "Ctrl+C" or "Ctrl+Shift+S".

The custom editor supports two ways to specify a keystroke. Either type any key stroke combination if the focus is 
in the first field or use the controls below.

The KeyStroke editor supports menu shortcut modifier key (  key on the Mac,  key otherwise).Command Ctrl
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ListModel (javax.swing)

This custom editor allows you to specify string values for a list.

Object (java.lang)

This editor allows you to reference any (non-visual) JavaBean as a property value. Often used for JLabel.
.labelFor

Paint (java.awt)

This editor allows you to specify a  object (used by ). Use the combo java.awt.Paint java.awt.Graphics2D

box at the top of the dialog to choose a paint type. In the mid area of the dialog you can edit the paint properties. 
This area is different for each paint type. At the bottom, you can see a preview of the paint. For GradientPaint you 
can click-and-drag the handles in the preview area to move the points.

Following paint types are supported:

Color

GradientPaint
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Point (java.awt)

Either edit the point in the property table or use the custom editor.

Rectangle (java.awt)

Either edit the rectangle in the property table or use the custom editor.

SpinnerModel (javax.swing)

This custom editor allows you to specify a spinner model (used by ). Use the combo box at the top of JSpinner

the dialog to choose a spinner model type (Number, Date or List). In the mid area of the dialog you can edit the 
model properties. This area is different for each model type. At the bottom, you can see a test spinner where you 
can test the spinner model.



JFormDesigner 8.3 Documentation

- 37 -

String (java.lang)

Either edit the string in the property table or use the custom editor. Switch the "allow new-line" check box on, if 
you want enter new lines.

String[] (java.lang)

This custom editor allows you to specify string values for a string array.
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TableModel (javax.swing)

This custom editor allows you to specify values for a table.

TreeModel (javax.swing)

This custom editor allows you to specify string values for a tree.
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2.6.6   Custom Property Values

Custom values allow you to use values specified in own code as property values in  view.Properties

Two types are supported:

Instance Values

Factory Values

Instance Values

A new instance of a class is created as property value.

An instance class must , must be  and must have a .extend property type public public no-args constructor

Example:

public  MyIcon  Icon {class implements

       getIconWidth()  {  ; }@Override public int return 16

       getIconHeight() {  ; }@Override public int return 16

       paintIcon( Component c, Graphics g,  x,  y ) {@Override public void int int

        g.setColor( Color.green );

        g.fillOval( x, y, ,  );16 16

    }

}

Generated source code in form that uses above icon:

label.setIcon(  MyIcon());new

Factory Values

A field or a getter method of factory class is used to get property value.

A factory class must be , must have  of  or public public static fields property type public static no-args methods
that return .property type

Example:

public  MyFactory {class

       Color  =  Color( , ,  );public static final MY_COLOR_1 new 192 0 0

      Color myColor2() {public static

          Color( , ,  );return new 128 0 0

    }

}

Generated source code in form that uses above factory:

label.setForeground(MyFactory. );MY_COLOR_1

label.setBackground(MyFactory.myColor2());
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Usage

Right-click on property in  view and select .Properties Custom Value

To use an instance value, select a class that extends the property type:

To use a factory value, first select a factory class and then choose a field or getter method:
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You can quickly apply recently used custom values by using the  submenu:Recent Custom Values
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2.7   Bindings View

The Bindings view displays and lets you edit all  of the form. The bindings and binding groups are shown bindings
in the order they will be bound.

This view is not visible by default. It appears at the bottom of the main window when you click the Show Bindings 

 button ( ) in the toolbar.View

The icon between the source and the target columns indicate the update strategy used by the binding:

Always sync (read-write)

Only read from source (read-only)

Read once from source (read-once)

Toolbar and context menu commands

Add Create a new binding.

Add Group Create a new binding group.

Remove Remove the selected bindings.

Properties Displays the properties of the selected binding in the .Binding dialog

Move Up Move the selected bindings up.

Move Down Move the selected bindings down.

Link with Designer Links the bindings selection to the active designer.

Close Closes the Bindings view.

Double-click on a binding item to see its details in the .Binding dialog
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2.8   Error Log View

This view appears at the bottom of the main window if an exception is throw by a bean. You can see which bean 
causes the problem and the stack trace of the exception. This makes it much easier to solve problems when using 
your own (or 3rd party) beans.

Toolbar commands

Copy Log Copies all log records to the clipboard.

Clear Log Clears the log.

Properties Displays the properties of the selected log record in a dialog (see below).

Close Closes the Error Log view.

Double-click on a log entry to see its details:

How to fix errors

This mainly depends on the error. The problem shown in the above screenshots is easy to fix by setting 
 to a value between 0 and 1.resizeWeight

If the problem occurs in your own beans, use the stack trace to locate the problem and fix it in your bean's source 

code. After compiling your bean, click the  button ( ) in the designer toolbar to reload your Refresh Designer
bean.

If you are using 3rd party beans, it is possible that you need to add additional libraries to the classpath. You 
should be able to identify such a problem on the kind of exception. In this case, add the needed libraries to the 
JFormDesigner classpath of the current , and refresh the Design view.Project
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3   Localization
JFormDesigner provides easy-to-use and powerful localization/internationalization support:

Externalize and  strings.internalize

Edit resource bundle strings.

Create new locales.

Delete locales.

Switch locale used in Design view.

In-place-editing strings of current locale.

Auto-externalize strings.

Choose existing strings.

Updates resource keys when renaming components.

Copies resource strings when copying components.

Removes resource strings when deleting components.

Localization preferences.

Use .properties or .xml files.

Fully integrated in undo/redo.

The locales combo box  in the toolbar allows you to select the locale used in the ,  and Design Structure Properties
views. If you  a localized string in the Design view , you change it in the current locale. Small flags  in-place-edit
in front of property values in the Properties view indicates that the string is localized (stored in a properties file).
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Create a new localized form

When creating a new form, you can specify that JFormDesigner should put all strings into a resource bundle (.
properties file). In the  dialog select the  check box, specify a resource New Form Store strings in resource bundle
bundle name and a prefix for generated keys. If  is selected, then JFormDesigner Auto-externalize strings
automatically puts all new strings into the properties file (auto-externalize). E.g. when you add a  to the JLabel

form and change the "text" and "toolTipText" properties, both strings will be put into the properties file.

To localize existing forms use .Externalize Strings
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Edit localization settings and resource bundle strings

To edit localization settings and resource bundle strings, select  from the main menu or click the Form > Localize

 button ( ) in the toolbar. Here you can create or delete locales and edit strings. The light gray color used Localize
to draw the string "Name:" in the table column "German" indicates that the string is inherited from a parent locale.

The  field is used to locate the properties files within the  of the current Resource bundle name Source Folders
. Use the  button to choose a resource bundle (.properties file).Project Browse

In the  field you can specify a prefix for generated resource bundle keys. The format for Prefix for generated keys
generated keys is "<prefix>.<componentName>.<propertyName>". You can change the separator ('.') in the 

.Localization preferences

If the  check box is selected, then JFormDesigner automatically puts all new strings into Auto-externalize strings
the properties file. E.g. when you add a  to the form and change the "text" and "toolTipText" properties, JLabel

both strings will be put into the properties file. You can exclude properties from externalization in the Localization 
.preferences
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Create new locale

To create a new locale, either select  from the main menu,  ( ) from the toolbar Form > New Locale New Locale
or click the  button in the  dialog. Select a language and an optional country. You can copy New Locale Localize
strings from an existing locale into the new locale, but JFormDesigner fully supports inheritance in the same way 
as specified by . E.g. if a message is not in locale "de_AT" then it will be loaded from java.util.ResourceBundle

locale "de".

Delete a locale

To delete an existing locale, either select  from the main menu,  ( ) from the Form > Delete Locale Delete Locale
toolbar or click the  button in the  dialog. Select the locale to delete.Delete Locale Localize
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Externalize strings

Externalizing allows you to move strings from a .jfd file to a .properties file. If you want localize existing forms, start 
here.

Select  from the main menu or  ( ) from the toolbar, specify the Form > Externalize Strings Externalize Strings
resource bundle name, the prefix for generated keys and select/deselect the strings to externalize. You can 
exclude properties from externalization in the .Localization preferences

You can also externalize and internalize properties in the  view.Properties
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Internalize strings

Internalizing allows you to move strings from a .properties file to a .jfd file.

Select  from the main menu or  ( ) from the toolbar, specify the Form > Internalize Strings Internalize Strings
locale to internalize from and select/deselect the strings to internalize. If you internalize all strings, JFormDesigner 
asks you whether you want to disable localization for the form.

Choose existing strings

The flag button ( ) in the  view, which is only available for localized forms and string properties, allows Properties
you to choose existing strings from the resource bundle of the form.

In the  dialog you can search for keys and/or values. Then select a key in the table and press OK to use Choose Key
its value in the form.
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4   Beans Binding (JSR 295)
JFormDesigner supports the Beans Binding specification (JSR 295).

A binding syncs two properties: the source property with the target property. The source is usually a (non-visual) 
 object and the target is usually a UI component (e.g. a ). Initially the value of the source data model JTextField

property is copied to the target property. Depending on the "Update strategy", a binding tracks changes on both 
properties and syncs the properties.

Beans Binding is open source and  part of the standard Java distribution. You must ship an additional not
library with your application. JFormDesigner includes ,  and beansbinding.jar beansbinding-doc.zip

 in its .beansbinding-src.zip redistributables
Maven Central: :  :  : groupId org.jdesktop artifactId beansbinding version 1.2.1

API documentation: doc.formdev.com/beansbinding/
Source code: github.com/JFormDesigner/swing-beansbinding

The  view  gives a good overview of all bindings in the form. The  button  makes Bindings Show Bindings View
this view visible. The  property category  in the  view shows the bindings of the selected Bindings Properties

component and you can add ( ), edit ( ) and remove ( ) bindings. Small arrows  indicate that the property is 
bound. Binding groups are also shown in the  view . The  palette category  provides useful Structure Binding
components.

https://doc.formdev.com/beansbinding/
https://github.com/JFormDesigner/swing-beansbinding
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Add/Edit Bindings

There are several ways to add/edit bindings:

Right-click on a component in the  or  view and select  from the popup menu. To edit an Design Structure Bind
existing binding, select a bound property from the  submenu.Bind

Click the  button ( / ) in the  property category in  view.Add/Edit Binding Bindings Properties

Right-click on a component property in the  view and select  from the popup menu.Properties Bind

Use the /  command in the  view.Add Properties Bindings

Remove Bindings

To remove existing bindings do one of:

Click the  button ( ) in the  property category in  view.Remove Binding Bindings Properties

Use the  command in the  view.Remove Bindings

Binding Dialog

This dialog enables you to edit all options of one binding.

General tab

Field Description

Source The source object.

Source 
path

The path (or expression) that identifies the source 
property.

Detail 
path

The path (or expression) that determines what is 
displayed to the user in the target JList.
(only if target is JList.elements)

Target The target object.

Target 
path

The path (or expression) that identifies the target 
property.

Update 
strategy

Specifies how the properties are kept synchronized. 
Possible values: "Always sync (read-write)", "Only read 
from source (read-only)" and "Read once from source 
(read-once)".

Update 
source 
when

Specifies when the source is updated from the target. 
Possible values: "While typing", "On focus lost" and "On 
focus lost or Enter key pressed".
(only if target is JTextComponent.text)

Ignore 
adjusting

If enabled, do not update properties until the user 
finished adjusting. E.g. while a slider is adjusting its value 
or while the list selection is being updated.
(only if target is JSlider.value, JList.selectedElement(s) or JTable.

selectedElement(s))
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Advanced tab

Field Description

Name The binding's name. Useful for BindingGroup.
.getBinding(name)

Group The group this binding belongs to.

Converter The  that converts the value from source Converter
type to target type and vice versa.

Validator The  that validates the value before passing it Validator
from the target back to the source property.

Source null Used if the value of the source property is null.

Source 
unreadable

Used if the source property is unreadable.

Target null Used if the value of the target property is null.

Bind 
immediately

Bind this binding immediately after creation. 
Otherwise, bind when the group is bound.

Table Binding tab

On this tab you can bind  element properties to  columns. Each item in the source  List<E> JTable List<E>

represents a row in the . See  for details about table binding.JTable JTableBinding

This tab is enabled if source is an instance of , target an instance of  java.util.List<E> javax.swing.JTable

and target property is .elements

Field Description

Editable Specifies whether the table cells 
are editable or not.

Columns The column bindings. The 
Source Path identifies the 
source property in . The <E>

Column Name is shown in the 
JTable column header. Each 
column binding may have its 
own ,  and Converter Validator
Alternative Values.

https://doc.formdev.com/beansbinding/org/jdesktop/beansbinding/BindingGroup.html#getBinding%28java.lang.String%29
https://doc.formdev.com/beansbinding/org/jdesktop/beansbinding/BindingGroup.html#getBinding%28java.lang.String%29
https://doc.formdev.com/beansbinding/org/jdesktop/beansbinding/Converter.html
https://doc.formdev.com/beansbinding/org/jdesktop/beansbinding/Validator.html
https://doc.formdev.com/beansbinding/org/jdesktop/swingbinding/JTableBinding.html
https://doc.formdev.com/beansbinding/org/jdesktop/beansbinding/Converter.html
https://doc.formdev.com/beansbinding/org/jdesktop/beansbinding/Validator.html
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Path or Expression

To address source or target properties you can either use a path or an expression. Select the Expression 
 button ( ) left to the input field to enter an expression.Language

A path (implemented by ) uses a dot-separated path syntax. E.g.  addresses the  BeanProperty task.title title

property of an object's  property. This is equivalent to .task source.getTask().getTitle()

An expression (implemented by ) uses the  (EL) also known from  and . ELProperty Expression Language JSP JSF
Besides a dot-separated path syntax to address properties (e.g. " ") it also supports following ${task.title}

:operators

Arithmetic: , , ,  and ,  and + - * / div % mod

Logical: , , , , , and && or || not !

Relational: , , , , , , , , , , , == eq != ne < lt > gt <= ge >= le

Empty: empty

Conditional: A ? B : C

EL expression examples:

EL expression Result

${task.title} The  property of an object's  property.title task

${firstName} ${lastName} Concatenation of  and  properties.firstName lastName

${mother.age > 65} true  if mother is older than 65,  otherwise.false

${image.width * image.height} Computes the number of pixels of an image.

${image.width * image.height * 4} Computes the number of bytes of an 32 bit image.

Following words are reserved for the EL and should not be used as identifiers:

  and   or    not   div   mod

  eq    ne    lt    gt    ge    le

  true  false null  empty instanceof

Data model

The data model used by Beans Binding (JSR 295) is based on the  specification. Getters are necessary to JavaBeans
read property values and setters to modify property values. On modifications, property change events should be 
fired so that beans binding can update the UI components. E.g.:

public  Task {class

     String title;private

     String getTitle() {public

         title;return

    }

      setTitle(String title) {public void

        String oldTitle = .title;this

        .title = title;this

        changeSupport.firePropertyChange( , oldTitle, title);"title"

    }

      PropertyChangeSupport changeSupport =  PropertyChangeSupport( );private final new this

      addPropertyChangeListener(PropertyChangeListener listener) {public void

        changeSupport.addPropertyChangeListener(listener);

    }

      removePropertyChangeListener(PropertyChangeListener listener) {public void

        changeSupport.removePropertyChangeListener(listener);

    }

}

https://doc.formdev.com/beansbinding/org/jdesktop/beansbinding/BeanProperty.html
https://doc.formdev.com/beansbinding/org/jdesktop/beansbinding/ELProperty.html
https://docs.oracle.com/javaee/6/tutorial/doc/gjddd.html
https://www.oracle.com/technetwork/java/javaee/jsp/index.html
http://javaserverfaces.java.net/
https://docs.oracle.com/javaee/6/tutorial/doc/bnaik.html
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1.  

2.  

3.  

4.  

5.  

6.  

7.  

Data model access

The source and target combo boxes in the  dialog offer only the components added to the form. To bind Binding
your data model to form components, you could add an instance of your data object to the form (using Choose 

), but this requires that the data object is a  with public null constructor, which is not always possible.Bean JavaBean

The preferred way to access the data model for binding is to add a getter for the data model to the form class. E.g.:

public  TaskViewForm  JPanel {class extends

     Task task;private

     Task getTask() {public

         task;return

    }

}

After compiling the form class, you can use  as binding source and  as binding source this task.someProperty

path.

Add a setter to the form class, if the whole data model may change. E.g.:

public  TaskViewForm  JPanel {class extends

      setTask(Task task) {public void

        Task oldTask = .task;this

        .task = task;this

        firePropertyChange( , oldTask, task);"task"

    }

}

How to bind data to a JTable

Beans Binding requires that the data is in a  (or ). The type of each data row java.util.List ObservableList
should be specified as type parameter to the list. E.g. . The data class should have java.util.List<MyData>

getters and setters for its values, which can bound to table columns.

Steps to bind a table:

Add a  component from the  palette category to the form. JFormDesigner creates java.util.List Bindings
a variable for the list in the Java code, but does not assign a value to it. It is up to you, to assign data to the list 
before invoking .initComponents()

Set the  property (expand the  property in  view) of the  to your data Type Parameters Class Properties List

class (e.g. ). Make sure that the data class is compiled and in the classpath of the project.MyData

Add a  to the form.JTable

Right-click on the table and select  from the popup menu, which opens the  dialog.Bind > elements Binding

On the  tab, set the source to your  object and leave the source path empty.General List

Switch to the  tab.Table Bindings

Click the  button and add columns.Add Multiple

Examples

For examples that use Beans Binding, take a look at the package com.jformdesigner.examples.
 in the .beansbinding examples

https://doc.formdev.com/beansbinding/org/jdesktop/observablecollections/ObservableList.html
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5   Projects
Stand-alone edition only. The  use the source folders and classpath from the IDE projects.IDE plug-ins

Projects allow you to store project specific options in project files. You can create new projects or open existing 
projects using the  or .menubar toolbar

When you start JFormDesigner the first time, it creates and opens a default project named DefaultProject.jfdproj in 
the folder ${user.home}/.jformdesigner, where ${user.home} is your home directory. You can see the value of 
${user.home} in the About dialog on the System tab.

You can use the default project, but it is recommended to create an own JFormDesigner project in your project 
root folder. Then you can commit the JFormDesigner project file into a version control system and reuse it on 
other computers. Paths in the project file are stored relative to the location of the project file. Project files have the 
extension .jfdproj

Pages

General
Source Folders
Classpath

Project specific  pages:preference

MigLayout
FormLayout (JGoodies)
GridBagLayout
null Layout
Localization
Java Code Generator

Templates
Layout Managers
Localization
Binding
Code Style

Client Properties

General

When creating a new project, you can specify a project name and the location where to store the project file.
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Source Folders

On this page, you can specify the locations of your Java source folders. Source folders are the root of packages 
containing .java files and are used find resource bundles for  and are also used by the localization Java code 

 to generate package statements.generator

If the folders list is focused, you can use the  key to add folders or the  key to delete selected folders.Insert Delete

Classpath

To use your custom components (JavaBeans), JFormDesigner needs to know, from where to load the JavaBean 
classes. Specify the locations of your custom JavaBeans on this page. You can add JAR files or folders containing .
class files.

If the classpath list is focused, you can use the  key to add folders/JAR files, the  key to delete Insert Delete
selected folders/JAR files,  keys to move selected items up or  keys to move selected items Ctrl+Up Ctrl+Down
down.
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6   Preferences
This dialog is used to set user preferences.

Stand-alone: Select  from the menu to open this dialog.Window > Preferences

Eclipse plug-in: The JFormDesigner preferences are fully integrated into the Eclipse preferences dialog. 
Select  from the menu to open it and then expand the node "JFormDesigner" in the Window > Preferences
tree.

IntelliJ IDEA plug-in: IntelliJ IDEA uses the term "Settings" instead of "Preferences". The JFormDesigner 
preferences are fully integrated into the IntelliJ IDEA settings dialog. Select  from the menu to File > Settings
open it and then select the "JFormDesigner" page.

NetBeans plug-in: NetBeans uses the term "Options" instead of "Preferences". The JFormDesigner 
preferences are fully integrated into the NetBeans options dialog. Select  from the menu to Tools > Options
open it and then select the "JFormDesigner" page.

Pages

General
MigLayout
FormLayout (JGoodies)
GridBagLayout
null Layout
Localization
Java Code Generator

Templates
Layout Managers
Localization
Binding
Code Style (  only)Stand-alone

Client Properties
Native Library Paths
BeanInfo Search Paths
Check for Updates

Import and export preferences

In the Preferences dialog, you can use the  ( ) button to import preferences from a file and the  (Import Export
) button to export preferences to a file. This preferences file is compatible with all JFormDesigner editions. On 
export, you can specify what parts of the preferences you want export.

You can also use IDE specific import/export commands:

Eclipse plug-in: You can use the menu commands  and  to import and export File > Import File > Export
preferences to/from Eclipse preferences files.

IntelliJ IDEA plug-in: You can use the menu commands  and  to File > Import Settings File > Export Settings
import and export settings to/from IntelliJ IDEA preferences files.

NetBeans plug-in: You can use the  and  buttons in the Options dialog to import and export Import Export
options to/from NetBeans options files.

Note: Each IDE uses its own file format for preferences. The only way to transfer preferences between the 
different JFormDesigner editions is to use JFormDesigner preferences files.

Restore defaults

Use the  ( ) button to restore the values of the active page to its defaults.Restore Defaults
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General

On this page, you can specify general options.

Option Description Default

Animate layout 
changes in Design view

If enabled, changes to the layout in the  view are done animated.Design On

Animation speed The speed of the animation. default

Buffer Design view in 
video memory

If enabled, parts of the  view are buffered in the video memory of the graphics Design
card to improve painting speed.

On

Undo history size The maximum number of steps in the undo history of a form. 1000

Form file format The format used to persist the form. Since version 5.1, JFormDesigner supports the 
compact, easy-to-merge and fast-to-load persistence format JFDML. To change the 
persistence format of an existing form, open the form, select the  node in the "(form)"
Structure view and change the "Form file format" property in the Properties view. Or 
use the JFormDesigner  to convert the format of many forms.command-line tool

JFDML

MigLayout

On this page, you can specify  related options.MigLayout

Option Description Default

Layout constraints The layout constraints used for new forms/containers. hidemode 3
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Option Description Default

Column constraints The column constraints used for new columns. fill

Row constraints The row constraints used for new rows.

FormLayout (JGoodies)

On this page, you can specify  related options.FormLayout

Option Description Default

Automatically insert
/remove gap columns
/rows

If enabled, JFormDesigner automatically inserts/removes gap columns/rows. On

JGoodies Forms version Required JGoodies Forms version for the created forms. auto-detect

Column/row templates 
for new columns/rows

Here you can specify the column and row templates that should be used when new 
columns or rows are inserted.

   Column The column template used for new columns. default

   Column gap The column template used for new gap columns. label 
component 
gap

   Row The row template used for new rows. default

   Row gap The row template used for new gap rows. line gap

Custom column/row 
templates

If the  does not fit to your needs, you can define your own here. predefined templates
Since JGoodies Forms 1.2, you can add these custom column/row templates to the 
global LayoutMap using the "LayoutMap Initialization Code" link.
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Custom column/row templates

Option Description

Display name The display name is used within JFormDesigner whenever the template is shown in combo boxes or 
popup menus.

Identifier The (unique) identifier is stored in form files. Choose a short string. Only letters and digits are 
allowed.

Use for Specifies whether the template should be used for columns, rows or both. Also specifies whether it 
represents a gap column/row.

Default alignment The default alignment of the components within a column/row. Used if the value of the component 
constraint properties "h align" or "v align" are set to DEFAULT.

Size The width of a column or height of a row. You can use default, preferred or minimum component 
size. Or a constant size. It is also possible to specify a minimum and a maximum size. Note that the 
maximum size does not limit the column/row size if the column/row can grow (see resize behavior).

Resize behavior The resize weight of the column/row.

Java code Optional Java code used by the Java code generator. Useful if you have factory classes for 
ColumnSpecs and RowSpecs. Not available for JGoodies Forms 1.2 and later.
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GridBagLayout

On this page, you can specify  related options.GridBagLayout

Option Description Default

Default properties for 
new columns/rows

Here you can specify the column and row properties that should be used when new 
columns or rows are inserted.

   Column The column properties used for new columns. fill:0:0.0

   Row The row properties used for new rows. fill:0:0.0

null Layout

On this page, you can specify  related options.null layout

Option Description Default

Snap to grid If enabled, snap to the grid specified below when moving or resizing a component in 
null layout.

On

Grid X step The horizontal step size of the grid. 5

Grid Y step The vertical step size of the grid. 5
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Localization

On this page, you can specify  related options.localization

Option Description Default

Rename resource keys 
when renaming 
components

If enabled, auto-rename resource keys when renaming components and 
the resource key contains the old component name.

On

Copy localized 
messages when 
copying components

If enabled, duplicate localized strings in all locales when copying 
components.

On

Delete localized 
messages when 
deleting components

If enabled, auto-delete localized strings, that were used by the deleted 
components, from all locales.

On

Delete localized 
messages when 
internalizing strings

If enabled, auto-delete localized strings, that were internalized, from all 
locales.

On

Delete messages only if 
key prefix is equal to 
form's key prefix

If enabled, messages will be auto-deleted only if their key prefix is equal to 
the key prefix of the form.

On

Insert new messages Specifies where new messages will be inserted into properties files. "next 
to similar keys" inserts new messages next to other similar keys so that 
messages that belong together are automatically at the same location in 
the properties file. "at the end of the properties file" always appends new 
messages to the end of the properties file.

next to similar keys 
(ascending order)

Format used for 
generated keys

Format used when generating a resource key. ${componentName}
${sep}${propertyName}

Separator used for 
generated keys

Separator used when generating a resource key. '.'

Encoding for properties 
files

Specifies encoding used for properties files. Since Java 9, UTF-8 is used by 
default for reading properties files in applications. Java 8 uses ISO-8859-1. (

 only; in  the encoding specified for .properties Stand-alone IDE plug-ins
files in the IDE preferences is used)

UTF-8 if running in Java 
9 or later; ISO-8859-1 if 
running in Java 8
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Option Description Default

Template for 
properties files

Template used when creating new properties files.

Exclude properties 
from externalization

Specify properties that should be excluded from externalization. Useful 
when using auto-externalization to ensure that some string property 
values stay in the Java code.

If the list is focused, you can use the  key to add a property or the Insert
 key to delete selected properties.Delete

Java Code Generator

On this page, you can turn off the Java code generator and specify other code generation options.

Option Description Default

Generate Java source 
code

If enabled, JFormDesigner generates Java source code when you save a form. On

Source compatibility Specifies the Java compatibility of the generated source code. Stand-alone: use 
Java 8

 use IDE plug-ins:
project setting

Explicit imports If enabled, the code generator adds explicit import statements (without '*') for 
used classes.

Off

Container blocks If enabled, the code generator puts the initialization code for each container 
into a block (enclosed in curly braces).

On

Comments If enabled, the code generator puts a comment line above the initialization 
code for each component.

On

Set component names If enabled, the code generator inserts  java.awt.Component.setName()

statements for all components of the form.
Off

Use Eclipse code If enabled, the Eclipse code formatter is used to format the generated code. ( Off
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Option Description Default

formatter  only)Eclipse plug-in

Eclipse non-nls tags (
//$NON-NLS-n$)

If enabled, the code generator appends non-nls comments to lines containing 
strings. These comments are used by the Eclipse IDE to denote strings that 
should not be externalized.

Off

IntelliJ IDEA non-nls 
tags (//NON-NLS)

If enabled, the code generator appends non-nls comments to lines containing 
strings. These comments are used by IntelliJ IDEA to denote strings that should 
not be externalized.

Off

NetBeans no-i18n tags (
//NOI18N)

If enabled, the code generator appends non-nls comments to lines containing 
strings. These comments are used by the NetBeans IDE to denote strings that 
should not be externalized.

Off

Use 'this' for member 
variables

If enabled, the code generator inserts 'this.' before all member variables. E.g. 
this.nameLabel.setText("Name:");

Off

Member variables 
prefix

Prefix used for component member variables. E.g. "m_".

Class modifiers Class modifiers used when generating a new class. Allowed modifiers: public
, ,  and .default abstract final

public

Nested class modifiers Class modifiers used when generating a new nested class. Allowed modifiers: 
, , , , ,  and .public default protected private abstract final static

private

Variable modifiers The default modifiers of the variables generated for components. Allowed 
modifiers: , , , ,  and public default protected private static

.transient

private

Event handler modifiers The default modifiers used when generating event handler methods. Allowed 
modifiers: , , , ,  and .public default protected private final static

private

You can set additional options per form in the ."(form)" properties

Templates (Java Code Generator)

This page contains templates that are used by the code generator when generating a new class. See Code 
 for details about templates.Templates
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New: Create a new template for a specific superclass.
: Edit the superclass of the selected user-defined template.Edit

: Remove the selected template. Only allowed for user-defined templates.Remove
: Reset the selected predefined template to the default.Reset

: Insert a variable at the current cursor location into the selected template.Insert Variable

Layout Managers (Java Code Generator)

On this page, you can specify code generation options for some layout managers.

Option Description Default

Use API constraints in 
generated code

If enabled, then MigLayout API is used to create constraints. Otherwise strings 
are used.

Off

Use PanelBuilder in 
generated code

If enabled, the PanelBuilder class of JGoodies Forms is used for FormLayout. Off

Make anonymous 
PanelBuilder JPanel 
transparent

If enabled, the JPanel of the PanelBuilder is made transparent. Off

Use empty 
GridBagConstraints 
constructor

If enabled, the empty GridBagConstraints constructor is used in the generated 
code, which is necessary for Java 1.0 and 1.1 compatibility. Since Java 1.2, 
GridBagConstraints has a constructor with parameters, which is used by 
default.

Off

TableLayout package Package name used by the Java code generator for TableLayout. Change this 
only if you have a copy of the original TableLayout in another package.

info.clearthought.
layout
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Localization (Java Code Generator)

On this page, you can specify code generation options for localization.

Option Description Default

Generate 
initComponentsI18n() 
method

If enabled, the code generator puts the code to initialize the localized texts 
into a method initComponentsI18n(). You can invoke this method from your 
code to switch the locale of a form at runtime. You can set this options also 
per form in the ."(form)" properties

Off

'getBundle' template Template used by code generator for getting a resource bundle. ResourceBundle.
getBundle
(${bundleName})

'getString' template Template used by code generator for getting a string from a resource bundle. ${bundle}.getString
(${key})

Binding (Java Code Generator)

On this page, you can specify code generation options for Beans Binding (JSR 295).

Option Description Default

Generate 
initComponentBindings()
method

If enabled, the code generator puts the code to create bindings into a method 
initComponentBindings(). You can set this options also per form in the "(form)" 

.properties

Off
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Code Style (Java Code Generator)

Stand-alone: On this page, you can specify code style options, which are used for code generation.

IDE plug-ins: This page is not available in IDE plug-ins because IDEs already have preferences that control code 
style. JFormDesigner uses the code style settings from IDE projects or preferences.

Option Description Default

Indent size The number of spaces used for one indentation level. 4

Tab size The number of spaces that represents one tabulation. 4

Use tab character Specifies whether the tab character (\t) is used for indentation or only space 
characters.

On

Line separator The line separator used for newly created .java and .properties files. Platform default

Encoding The character encoding used for reading and writing Java files. Platform default

Client Properties

On this page, you can define , which can be set in the  view.client properties Properties

If the client properties list is focused, you can use the  key to add a client property or the  key to Insert Delete
delete selected client properties.
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Option Description Default

Use FlatLaf client 
properties See

If enabled,  are added to  view under FlatLaf Client Properties Properties Client 
 category.Properties

On

Use class 
'FlatClientProperties' in 
generated Java code

If enabled, the class  is used in generated code for FlatLaf FlatClientProperties

client properties. If disabled, Java strings are used.
On

Option Description

Key The key that identifies the client property.

Component class(es) The component class(es) to which the client property belongs. E.g. if set to javax.swing.JButton, then 
the client property is shown in the  view for buttons and for subclasses of JButton. To Properties
specify multiple classes, separate them with commas. If not specified, the client property is shown 
for all JComponent components.

Value type The type of the client property value. You can select one of the common types (String, Boolean, 
Integer, etc) from the combo box or enter the class name of a custom type.

Predefined values If the value type is java.lang.String, then you can specify predefined values for the client property. 
When editing the client property in the  view, a combo box that contains these values is Properties
shown. The combo box is editable by default. Select the "Allow only predefined values" check box to 
make the combo box not-editable.

Property editor class Optional class name of a property editor that should be used when editing the client property in the 
 view.Properties

https://www.formdev.com/flatlaf/client-properties/
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Native Library Paths

On this page, you can specify the locations of custom JavaBeans that use native libraries and you can specify the 
folders where to search for the native libraries.

Note: When removing or changing paths, a restart of JFormDesigner (or the IDE) is probably necessary to make 
the changes work.

Option Description

Classpath for 
JavaBeans, which use 
native libraries

JAR files or folders containing .class files, which are using native libraries. They must be specified 
here to ensure that the native libraries are loaded from a special class loader only once.

Native Library Path Folders used to search for native libraries.

BeanInfo Search Paths

On this page, you can specify package names that will be used for finding BeanInfo classes and property editors.

Option Description

BeanInfo search path Package names that will be used for finding BeanInfo classes. Only necessary if the BeanInfo class is 
not in the same package as the component class to which it belongs. See  java.beans.Introspector
and  for details.Introspector.setBeanInfoSearchPath()

Property editor search 
path

Package names that will be used for finding property editors. Only necessary if the property editor is 
not in the same package as the property type to which it belongs. See java.beans.

 and  for details.PropertyEditorManager PropertyEditorManager.setEditorSearchPath()

https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/Introspector.html
https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/Introspector.html#setBeanInfoSearchPath%28java.lang.String%5B%5D%29
https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/PropertyEditorManager.html
https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/PropertyEditorManager.html
https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/PropertyEditorManager.html#setEditorSearchPath%28java.lang.String%5B%5D%29
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Check for Updates

This page allows you to specify whether JFormDesigner should check for updates and new versions. Click the 
"Check Now" button to check for updates immediately.
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7   IDE Integrations
JFormDesigner is available as stand-alone application and as plug-ins for various IDEs. The IDE plug-ins completely 
integrate JFormDesigner into the IDEs.

Following IDE plug-ins are available:

Eclipse plug-in

IntelliJ IDEA plug-in

NetBeans plug-in

Other IDEs

If there is no JFormDesigner plug-in for your favorite IDE, you can use the stand-alone edition of JFormDesigner 
side by side with your IDE.

IDE interworking with stand-alone edition

Care must be taken because you edit the Java source in the IDE and JFormDesigner stand-alone also modifies the 
Java source file when generating code for the form. As long as you follow the following rule, you will never have a 
problem:

Save the Java file in the IDE  saving the form in JFormDesigner stand-alone.before

Your IDE will recognize that the Java file was modified outside of the IDE and will reload it. Some IDEs ask the user 
before reloading files, other IDEs silently reload files.

If you have not saved the Java file in the IDE, then you should prevent the IDE from reloading it. In this case save 
the Java file in the IDE and then use  in JFormDesigner stand-alone.Generate Java Code

JFormDesigner generates Java code when you either  the form or select . JFormDesigner Save Generate Java Code
does not hold a copy of the Java source in memory. Every time JFormDesigner generates Java code, it first reads 
the Java source file, parses it, updates it and writes it back to the disk.
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7.1   Eclipse plug-in

This plug-in integrates JFormDesigner into  and other Eclipse based IDEs.Eclipse

Benefits

Using this plug-in has following benefits compared to JFormDesigner stand-alone edition:

Fully integrated as editor for JFormDesigner .jfd files. Create and design forms within Eclipse. No need to 
switch between applications.

Uses the source folders and classpath of the current Eclipse project. No need to specify them twice.

The Java code generator updates the .java file in-memory on each change in the designer. You can design 
forms and edit its source code without the need to save them (as necessary when using JFormDesigner stand-
alone edition).

Folding of generated GUI code in Java editor.

Go to event handler method in Java editor.

Two-way synchronization of localized strings in designer and in properties file editors. Changing localized 
strings in the designer immediately updates the .properties file in-memory and changing the .properties file 
updates the designer.

Copy needed libraries (MigLayout, JGoodies Forms, TableLayout, etc) to the project and add them to the 
classpath of the current Eclipse project. Optionally include source code and Javadoc.

Integrated into refactoring:
Copy, rename, move or delete .jfd files when coping, renaming, moving or deleting .java files.

JFormDesigner .jfd files and palette are updated when using , Refactor > Rename Refactor > Move

,  or  on packages, classes, fields Refactor > Change Method Signature Rename in workspace

and methods.

Rename component in Design view allows using Eclipse Java refactoring to rename all occurrences of 
the component name (including Preview).

Rename/move .properties files updates .jfd and .java files.

Rename nested class updates .jfd file.

https://www.eclipse.org/
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User interface

The screenshot below shows the Eclipse main window editing a JFormDesigner form. JFormDesigner adds the 
menu  to the main menu, which is only visible if a JFormDesigner form editor is active.Form

A JFormDesigner editor consists of:

Toolbar: Located at top of the editor area.

Palette: Located at the left side.

Design View: Located at the center.

Structure View: Located in Eclipse's Outline view.

Properties View: Located in Eclipse's Properties view.

Bindings View: Located below the Design view. This view is not visible by default. Click the Show Bindings 

 button ( ) in the toolbar to make is visible.View

Error Log View: Automatically opens on errors in a view at the bottom.

Creating new forms

To create a new form, click the  ( ) button in the Eclipse toolbar.New JFormDesigner Form



JFormDesigner 8.3 Documentation

- 74 -

You can also create new forms in Eclipse's Package Explorer view. First select the destination package or folder, 
then invoke Eclipse's  command and select , which opens Eclipse's  dialog. Then choose New Other New

 from the list of wizards and click Next to proceed.JFormDesigner Form

In the  dialog, enter the form name (which is also used as class name), choose a New JFormDesigner Form
superclass, a  and set  options.layout manager localization

Open forms for editing

You can open existing forms the same way as opening any other file in Eclipse. Locate it in Eclipse's Package 
Explorer view and double-click it.

Go to Java code / Go to form

JFormDesigner adds a button to Eclipse's main toolbar that enables you to switch quickly from a JFormDesigner 

form editor to its Java editor and vice versa. If a form editor is active, then the button is named  (Go to Java code

). If a Java editor is active, then it is named  ( ). You can also use  ( : Go to JFormDesigner form Ctrl+Shift+D Mac
).Shift+Command+D

   

Code folding

To move the generated code out of the way, JFormDesigner folds it in the Java editor.



JFormDesigner 8.3 Documentation

- 75 -

Convert NetBeans and IntelliJ IDEA forms

You can convert existing NetBeans and IntelliJ IDEA forms to JFormDesigner forms. Right-click on the form file (or 
any container) and select .Convert to JFormDesigner Form

When converting an IntelliJ IDEA form, JFormDesigner inserts its own generated GUI code into the existing Java 
class and removes IntelliJ IDEA's GUI code.

Preferences

The JFormDesigner preferences are fully integrated into the Eclipse preferences dialog. Select Window > 
 from the menu to open it and then expand the node "JFormDesigner" in the tree. See  for Preferences Preferences

details.

You can also set project specific settings in the Eclipse project dialog. Select  from the menu Project > Properties
to open it and then expand the node "JFormDesigner" in the tree. See  for details.Preferences

Keyboard shortcuts

You can assign shortcut keys to JFormDesigner commands in Eclipse's keys preferences. Select Window > 
 to open it. Search for "JFormDesigner" to find JFormDesigner commands.Preferences > General > Keys



JFormDesigner 8.3 Documentation

- 76 -

7.2   IntelliJ IDEA plug-in

This plug-in integrates JFormDesigner into   (Community and Ultimate Editions).Jetbrains IntelliJ IDEA

Benefits

Using this plug-in has following benefits compared to JFormDesigner stand-alone edition:

Fully integrated as editor for JFormDesigner .jfd files. Create and design forms within IntelliJ IDEA. No need to 
switch between applications.

Uses the source folders and classpath of the current IntelliJ IDEA project/module. No need to specify them 
twice.

The Java code generator updates the .java file in-memory on each change in the designer. You can design 
forms and edit its source code without the need to save them (as necessary when using JFormDesigner stand-
alone edition).

Folding of generated GUI code in Java editor.

Go to event handler method in Java editor.

Two-way synchronization of localized strings in designer and in properties file editors. Changing localized 
strings in the designer immediately updates the .properties file in-memory and changing the .properties file 
updates the designer.

Copy needed libraries (MigLayout, JGoodies Forms, TableLayout, etc) to the project and add them to the 
classpath of the current IntelliJ IDEA project/module. Optionally include source code and Javadoc.

Assign shortcut keys to most JFormDesigner commands in IntelliJ IDEA's keymap settings.

User interface

The screenshot below shows the IntelliJ IDEA main window editing a JFormDesigner form.

A JFormDesigner editor consists of:

Toolbar: Located at top of the editor area.

https://www.jetbrains.com/
https://www.jetbrains.com/idea/


JFormDesigner 8.3 Documentation

- 77 -

Palette: Located at the left side.

Design View: Located at the center.

Structure View: Located at the upper right. You can hide this view in the editor and show it instead in IntelliJ 

IDEA's Structure tool window by unselecting  ( ).Show Structure in Editor

Properties View: Located at the lower right.

Bindings View: Located below the Design view. This view is not visible by default. Click the Show Bindings 

 button ( ) in the toolbar to make is visible.View

Error Log View: Automatically opens on errors in a tool window at the bottom. This view is not visible in the 
above screenshot.

Creating new forms

You can create new forms in any of IntelliJ IDEA's project views. First select the destination package or folder, then 
invoke IDEA's  command and choose .New JFormDesigner Form

In the  dialog, enter the form name (which is also used as class name), choose a New JFormDesigner Form
superclass, a  and set  options.layout manager localization

Open forms for editing

You can open existing forms the same way as opening any other file in IntelliJ IDEA. Locate it in any of IntelliJ IDEA's 
project views and double-click it.

Go to Java code / Go to form

JFormDesigner adds a button to IntelliJ IDEA's main toolbar that enables you to switch quickly from a 
JFormDesigner form editor to its Java editor and vice versa. If a form editor is active, then the button is named Go 

 ( ). If a Java editor is active, then it is named  ( ). You can also use to Java code Go to JFormDesigner form
 ( : ).Ctrl+Shift+D Mac Shift+Command+D
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Code folding

To move the generated code out of the way, JFormDesigner folds it in the Java editor.

Convert IntelliJ IDEA and NetBeans forms

You can convert existing IntelliJ IDEA and NetBeans forms to JFormDesigner forms. Right-click on the form file (or 
any container) and select .Convert to JFormDesigner Form

When converting an IntelliJ IDEA form, JFormDesigner inserts its own generated GUI code into the existing Java 
class and removes IntelliJ IDEA's GUI code.

Settings

JFormDesigner uses the term "Preferences" instead of IntelliJ IDEA's "Settings". The JFormDesigner preferences are 
fully integrated into the IntelliJ IDEA settings dialog. Select  from the menu to open it and then select File > Settings
the "JFormDesigner" page. To set project specific settings, select the subpage named "Project Specific". See 

 for details.Preferences

Keyboard shortcuts

You can assign shortcut keys to most JFormDesigner commands in IntelliJ IDEA's keymap settings. Select File > 
 to open it. In the actions tree expand .Settings > Keymap Plug-ins > JFormDesigner
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7.3   NetBeans plug-in

This plug-in integrates JFormDesigner into .NetBeans

Benefits

Using this plug-in has following benefits compared to JFormDesigner stand-alone edition:

Fully integrated as editor for JFormDesigner .jfd files. Create and design forms within NetBeans. No need to 
switch between applications.

Uses the source folders and classpath of the current NetBeans project. No need to specify them twice.

The Java code generator updates the .java file in-memory on each change in the designer. You can design 
forms and edit its source code without the need to save them (as necessary when using JFormDesigner stand-
alone edition).

Folding and guarding of generated GUI code in Java editor.

Go to event handler method in Java editor.

Two-way synchronization of localized strings in designer and in properties file editors. Changing localized 
strings in the designer immediately updates the .properties file in-memory and changing the .properties file 
updates the designer.

Automatically add needed libraries (MigLayout, JGoodies Forms, TableLayout, etc) to the project.

Integrated into refactoring: Copy, rename, move or delete .jfd files when coping, renaming, moving or 
deleting .java files.

User interface

The screenshot below shows the NetBeans main window editing a JFormDesigner form.

A JFormDesigner editor consists of:

Toolbar: Located at top of the editor area.

Palette: Located at the left side.

Design View: Located at the center.

Structure View: Located at the lower left.

https://netbeans.apache.org/
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Properties View: Located at the right side.

Bindings View: Located below the Design view. This view is not visible by default. Click the Show Bindings 

 button ( ) in the toolbar to make is visible.View

Error Log View: Automatically opens on errors in a view at the bottom.

Creating new forms

You can create new forms using NetBeans's  command. In the category  choose New File Swing GUI Forms
 and click Next to proceed.JFormDesigner Form

Open forms for editing

You can open existing forms the same way as opening any other file in NetBeans. Locate it in NetBeans's Project 
view and double-click it.

Source / Design

The  and  toggle buttons in the editor toolbar enable you to switch from a JFormDesigner form Source Design
editor to its Java editor and vice versa.
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Convert NetBeans and IntelliJ IDEA forms

You can convert existing NetBeans and IntelliJ IDEA forms to JFormDesigner forms. Right-click on the form file (or 
any container) and select .Tools > Convert to JFormDesigner Form

When converting an IntelliJ IDEA form, JFormDesigner inserts its own generated GUI code into the existing Java 
class and removes IntelliJ IDEA's GUI code.

Options

JFormDesigner uses the term "Preferences" instead of NetBeans "Options". The JFormDesigner preferences are 
fully integrated into the NetBeans options dialog. Select  from the menu to open it and then select Tools > Options
the "JFormDesigner" page. See  for details.Preferences

You can also set project specific options in the NetBeans project dialog. Select  from the File > Project Properties
menu to open it and then expand the node "JFormDesigner" in the tree. See  for details.Preferences

Keyboard shortcuts

You can assign shortcut keys to some JFormDesigner commands in NetBeans keymap options. Select Tools > 
 to open it. Click on the Category column to sort key bindings by category name and scroll to Options > Keymap

the JFormDesigner category.
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8   Layout Managers
Layout managers are an essential part of Swing forms. They lay out components within a container. 
JFormDesigner provides support for following layout managers:

BorderLayout

BoxLayout

CardLayout

FlowLayout

FormLayout (JGoodies)

GridBagLayout

GridLayout

GroupLayout (Free Design)

HorizontalLayout (SwingX)

IntelliJ IDEA GridLayout

MigLayout

null Layout

TableLayout

VerticalLayout (SwingX)

How to choose a layout manager?

For  use either one of the grid-based layout managers ( , ,  or "normal" forms MigLayout FormLayout TableLayout
) or use "Free Design" ( ). Each layout manager has its advantages and disadvantages. GridBagLayout GroupLayout

MigLayout, FormLayout and TableLayout are open source and require that you ship an additional library with your 
application.

MigLayout has most features (units, alignment, grouping, docking, flowing, in-cell flow and more).

FormLayout has many features (dialog units, column/row alignment, column/row grouping), but may have 
problems if a component spans multiple columns or rows and can not handle right-to-left component 
orientation.

TableLayout does not have these limitations, but has fewer features than FormLayout.

GridBagLayout is the weakest of these four grid-based layout managers, but JFormDesigner hides its 
complexity and adds additional features like gaps. Use GridBagLayout if you cannot use MigLayout, 
FormLayout or TableLayout.

GroupLayout (Free Design) allows you to lay out your forms by simply placing components where you want 
them. Visual guidelines suggest optimal spacing, alignment and resizing of components.

For  use , , ,  or .button bars MigLayout FormLayout TableLayout GridBagLayout FlowLayout

To layout a , use . Place the toolbar to the north, the status bar to the south and the main window BorderLayout
content to the center.

For  use , which has its own layout manager (based on BoxLayout).toolbars JToolBar

For ,  may be a good choice. Mainly because  has a gap between its radio button groups BoxLayout JRadioButton

text and its border and therefore the gaps provided by FormLayout, TableLayout and GridBagLayout are not 
necessary.
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Change layout manager

You can change the layout manager at any time. Either in the  view or by right-clicking on a container in Properties
the  or  view and selecting the new layout manager from the popup menu.Design Structure
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8.1   BorderLayout

The border layout manager places components in up to five areas: center, north, south, east and west. Each area 
can contain only one component.

(absolute positioning) (left-to-right relative positioning) (right-to-left relative positioning)

The components are laid out according to their preferred sizes. The north and south components may be 
stretched horizontally. The east and west components may be stretched vertically. The center component may be 
stretched horizontally and vertically to fill any space left over.

In addition to absolute positioning, BorderLayout supports relative positioning, which swaps west and east 
components if the component orientation of the container is set to right-to-left. To use relative positioning, first 
add a component to one of the four side areas and then change the layout constraints property of that 
component to PAGE_START, PAGE_END, LINE_START or LINE_END.

BorderLayout is part of the standard Java distribution. The API documentation is available .here

Layout manager properties

A container with this layout manager has following :layout manager properties

Property Name Description Default

horizontal gap The horizontal gap between components. 0

vertical gap The vertical gap between components. 0

Layout constraints properties

A component contained in a container with this layout manager has following :layout constraints properties

Property Name Description

constraints Specifies where the component will be placed. Possible values: CENTER, NORTH, SOUTH, EAST, 
WEST, PAGE_START, PAGE_END, LINE_START and LINE_END.

https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/awt/BorderLayout.html
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8.2   BoxLayout

The box layout manager places components either vertically or horizontally. The components will not wrap as in 
.FlowLayout

This layout manager is used rarely. Take a look at the BoxLayout API documentation for more details about it.

BoxLayout is part of the standard Java distribution. The API documentation is available .here

Layout manager properties

A container with this layout manager has following :layout manager properties

Property Name Description

axis The axis to lay out components along. Possible values: X_AXIS, Y_AXIS, LINE_AXIS and PAGE_AXIS.

https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/javax/swing/BoxLayout.html
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8.3   CardLayout

The card layout manager treats each component in the container as a card. Only one card is visible at a time. The 
container acts as a stack of cards. The first component added to a card layout is the visible component when the 
container is first displayed.

CardLayout is part of the standard Java distribution. The API documentation is available .here

Layout manager properties

A container with this layout manager has following :layout manager properties

Property Name Description Default

horizontal gap The horizontal gap at the left and right edges. 0

vertical gap The vertical gap at the top and bottom edges. 0

Layout constraints properties

A component contained in a container with this layout manager has following :layout constraints properties

Property Name Description

Card Name Identifier that can be used to make a card visible. See API documentation for CardLayout.show
.(Container, String)

https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/awt/CardLayout.html
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8.4   FlowLayout

The flow layout manager arranges components in a row from left to right, starting a new row if no more 
components fit into a row. Flow layouts are typically used to arrange buttons in a panel.

    

FlowLayout is part of the standard Java distribution. The API documentation is available .here

Layout manager properties

A container with this layout manager has following :layout manager properties

Property Name Description Default

alignment The alignment of the layout. Possible values: LEFT, RIGHT, CENTER, LEADING and 
TRAILING.

CENTER

horizontal gap The horizontal gap between components and between the component and the border 
of the container.

5

vertical gap The vertical gap between components and between the component and the border of 
the container.

5

align on baseline Specifies whether components are vertically aligned along their baseline. Components 
that do not have a baseline are centered.

false

https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/awt/FlowLayout.html
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8.5   FormLayout (JGoodies)

FormLayout is a powerful, flexible and precise general purpose layout manager. It places components in a grid of 
columns and rows, allowing specified components to span multiple columns or rows. Not all columns/rows 
necessarily have the same width/height.

Unlike other grid-based layout managers, FormLayout uses 1-based column/row indices. And it uses "real" 
columns/rows as gaps. Therefore the unusual column/row numbers in the above screenshot. Using gap columns
/rows has the advantage that you can give gaps different sizes.

Use the column and row  to insert or delete columns/rows and change column/row properties. headers
JFormDesigner automatically adds/removes gap columns if you add/remove a column/row.

Compared to other layout managers, FormLayout provides following outstanding features:

Default alignment of components in a column/row.

Specification of minimum and maximum column width or row height.

Supports different units: Dialog units, Pixel, Point, Millimeter, Centimeter and Inch. Especially Dialog units are 
very useful to create layouts that scale with the screen resolution.

Column/row templates.

Column/row grouping.

FormLayout is open source and  part of the standard Java distribution. You must ship two additional not
libraries with your application. JFormDesigner includes  and  jgoodies-forms.jar jgoodies-common.jar

in its . For more documentation and tutorials, visit redistributables www.jgoodies.com/freeware/libraries
./forms/

Maven Central: :  :  : groupId com.jgoodies artifactId jgoodies-forms version 1.8.0

API documentation: doc.formdev.com/jgoodies-forms/
Source code: github.com/JFormDesigner/swing-jgoodies-forms

IDE plug-ins: If you use FormLayout the first time, the JFormDesigner IDE plug-in ask you whether it should 
copy the required libraries (and its source code and documentation) to the IDE project and add it to the 
classpath of the IDE project.

Layout manager properties

A container with this layout manager has following :layout manager properties

Property Name Description

columnSpecs Comma separated encoded column specifications. This property is for experts only. Use the column 
 instead of editing this property.header

rowSpecs Comma separated encoded row specifications. This property is for experts only. Use the  row header
instead of editing this property.

http://www.jgoodies.com/freeware/libraries/forms/
http://www.jgoodies.com/freeware/libraries/forms/
https://doc.formdev.com/jgoodies-forms/
https://github.com/JFormDesigner/swing-jgoodies-forms
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Column/row properties

Each column and row has its own properties. Use the column and row  to change column/row properties.headers

Field Description

Column
/Row

The index of the column/row. Use the arrow 
buttons (or , , ,  Alt+Left Alt+Right Alt+Up Alt+Down
keys) to edit the properties of the previous or next 
column/row.

Template FormLayout provides several  predefined templates
for columns and rows. Here you can choose one.

Specification The column/row specification. This is a string 
representation of the options below.

Default 
alignment

The default alignment of the components within a 
column/row. Used if the value of the component 
constraint properties "h align" or "v align" are set to 
DEFAULT.

Size The width of a column or height of a row. You can 
use default, preferred or minimum component 
size. Or a constant size. It is also possible to specify 
a minimum and a maximum size. Note that the 
maximum size does not limit the column/row size if 
the column/row can grow (see resize behavior).

Resize 
behavior

The resize weight of the column/row.

Grouping See  for details.column/row grouping

Tip: The column/row context menu allows you to alter many of these options for multi-selections.

Layout constraints properties

A component contained in a container with this layout manager has following :layout constraints properties

Property Name Description Default

grid x Specifies the component's horizontal grid origin (column index). 1

grid y Specifies the component's vertical grid origin (row index). 1

grid width Specifies the component's horizontal grid extend (number of columns). 1

grid height Specifies the component's vertical grid extend (number of rows). 1

h align The horizontal alignment of the component within its cell. Possible values: DEFAULT, 
LEFT, CENTER, RIGHT and FILL.

DEFAULT

v align The vertical alignment of the component within its cell. Possible values: DEFAULT, TOP, 
CENTER, BOTTOM and FILL.

DEFAULT

insets Specifies the external padding of the component, the minimum amount of space 
between the component and the edges of its display area.
Note that the insets do not increase the column width or row height (in contrast to the 
GridBagConstraints.insets).

0,0,0,0

Tip: The component context menu allows you to alter the alignment for multi-selections.
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Column/Row Templates

FormLayout provides several predefined templates for columns and rows. You can also define custom column
 in the  dialog./row templates Preferences

Column templates

Name Description Gap

default Determines the column width by computing the maximum of all column component preferred 
widths. If there is not enough space in the container, the column can shrink to the minimum 
width.

no

preferred Determines the column width by computing the maximum of all column component preferred 
widths.

no

minimum Determines the column width by computing the maximum of all column component minimum 
widths.

no

related gap A logical horizontal gap between two related components. For example the OK and Cancel 
buttons are considered related.

yes

unrelated gap A logical horizontal gap between two unrelated components. yes

label component gap A logical horizontal gap between a label and an associated component. yes

glue Has an initial width of 0 pixels and grows. Useful to describe  columns that fill the space glue
between other columns.

yes

button A logical horizontal column for a fixed size button. no

growing button A logical horizontal column for a growing button. no

Row templates

Name Description Gap

default Determines the row height by computing the maximum of all row component preferred 
heights. If there is not enough space in the container, the row can shrink to the minimum 
height.

no

preferred Determines the row height by computing the maximum of all row component preferred 
heights.

no

minimum Determines the row height by computing the maximum of all row component minimum 
heights.

no

related gap A logical vertical gap between two related components. yes

unrelated gap A logical vertical gap between two unrelated components. yes

label component gap A logical vertical gap between a label and an associated component.
(requires JGoodies Forms 1.4 or later)

yes

narrow line gap A logical vertical narrow gap between two rows. Useful if the vertical space is scarce or if an 
individual vertical gap shall be smaller than the default line gap.

yes

line gap A logical vertical default gap between two rows. A little bit larger than the narrow line gap. yes

paragraph gap A logical vertical default gap between two paragraphs in the layout grid. This gap is larger than 
the default line gap.

yes

glue Has an initial height of 0 pixels and grows. Useful to describe  rows that fill the space glue
between other rows.

yes
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8.6   GridBagLayout

The grid bag layout manager places components in a grid of columns and rows, allowing specified components to 
span multiple columns or rows. Not all columns/rows necessarily have the same width/height. Essentially, 
GridBagLayout places components in rectangles (cells) in a grid, and then uses the components' preferred sizes to 
determine how big the cells should be.

Use the column and row  to insert or delete columns/rows and change column/row properties.headers

GridBagLayout is part of the standard Java distribution. The API documentation is available .here

Extensions

JFormDesigner extends the original GridBagLayout with following features:

Horizontal and vertical gaps
Simply specify the gap size and JFormDesigner automatically computes the  GridBagConstraints.insets

for all components. This makes designing a form with consistent gaps using GridBagLayout much easier. No 
longer wrestling with .GridBagConstraints.insets

With gaps: Without gaps:

Left/top layout alignment
The pure GridBagLayout centers the layout within the container if there is enough space. JFormDesigner 
easily allows you to fix this problem by switching on two options:  and .align left align top

With layout alignment: Without layout alignment:

Default component alignment
Allows you to specify a default alignment for components within columns/rows. This is very useful for 
columns with right aligned labels because you specify the alignment only once for the column and all added 
labels will automatically aligned to the right.

Layout manager properties

A container with this layout manager has following :layout manager properties

Property Name Description Default

horizontal gap The horizontal gap between components. 5

vertical gap The vertical gap between components. 5

align left If true, aligns the layout to the left side of the container. If false, then the layout is 
centered horizontally.

true

align top If true, aligns the layout to the top side of the container. If false, then the layout is 
centered vertically.

true

https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/awt/GridBagLayout.html
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These four properties are JFormDesigner extensions to the original GridBagLayout. However, no additional library 
is required.

Column/row properties

Each column and row has its own properties. Use the column and row  to change column/row properties.headers

Field Description

Column/Row The index of the column/row. Use the arrow buttons (or , , ,  Alt+Left Alt+Right Alt+Up Alt+Down
keys) to edit the properties of the previous or next column/row.

Default alignment The default alignment of the components within a column/row. Used if the value of the constraints 
properties "h align" or "v align" is DEFAULT.

Size The minimum width of a column or height of a row.

Resize behavior The resize weight of the column/row.

Tip: The column/row context menu allows you to alter many of these options for multi-selections.

Layout constraints properties

A component contained in a container with this layout manager has following :layout constraints properties

Property Name Description Default

grid x Specifies the component's horizontal grid origin (column index). 0

grid y Specifies the component's vertical grid origin (row index). 0

grid width Specifies the component's horizontal grid extend (number of columns). 1

grid height Specifies the component's vertical grid extend (number of rows). 1

h align The horizontal alignment of the component within its cell. Possible values: DEFAULT, 
LEFT, CENTER, RIGHT and FILL.

DEFAULT

v align The vertical alignment of the component within its cell. Possible values: DEFAULT, TOP, 
CENTER, BOTTOM, FILL, BASELINE, ABOVE_BASELINE and BELOW_BASELINE.

DEFAULT

weight x Specifies how to distribute extra horizontal space. 0.0

weight y Specifies how to distribute extra vertical space. 0.0

insets Specifies the external padding of the component, the minimum amount of space 
between the component and the edges of its display area.

0,0,0,0

ipad x Specifies the internal padding of the component, how much space to add to the 0
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Property Name Description Default

minimum width of the component.

ipad y Specifies the internal padding, that is, how much space to add to the minimum height 
of the component.

0

In contrast to the GridBagConstraints API, which uses  and  to specify the alignment and resize anchor fill

behavior of a component, JFormDesigner uses the usual  notation.h/v align

Tip: The component context menu allows you to alter the alignment for multi-selections.
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8.7   GridLayout

The grid layout manager places components in a grid of cells. Each component takes all the available space within 
its cell, and each cell is exactly the same size.

This layout manager is used rarely.

GridLayout is part of the standard Java distribution. The API documentation is available .here

Layout manager properties

A container with this layout manager has following :layout manager properties

Property Name Description Default

columns The number of columns. Zero means any number of columns.

rows The number of rows. Zero means any number of rows.
: If the number of rows is non-zero, the number of columns specified is ignored. Note

Instead, the number of columns is determined from the specified number of rows and 
the total number of components in the layout.

horizontal gap The horizontal gap between components. 0

vertical gap The vertical gap between components. 0

https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/awt/GridLayout.html
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8.8   GroupLayout (Free Design)

The goal of the group layout manager is to make it easy to create professional cross platform layouts. It is 
designed for GUI builders, such as JFormDesigner, to use the "Free Design" paradigm. You can lay out your forms 
by simply placing components where you want them. Visual guidelines suggest optimal spacing, alignment and 
resizing of components.

GroupLayout has been developed by the NetBeans team and is also used by the NetBeans GUI Builder (formerly 
Project Matisse). They provide a comprehensive tutorial on designing GUIs using GroupLayout, which is also 
suitable for JFormDesigner: https://netbeans.apache.org/kb/docs/java/quickstart-gui.html

GroupLayout is part of the standard Java distribution. The API documentation is available .here

Alignment guidelines

Alignment guidelines appear only when adding or moving components. They indicate the preferred positions to 
which components snap when releasing the mouse button.

Insets are the preferred spacings between components and their container.

Offsets are the preferred spacings between adjacent components.

Baseline alignment is the preferred relationship between adjacent components that display text.

https://netbeans.apache.org/kb/docs/java/quickstart-gui.html
https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/javax/swing/GroupLayout.html
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Edge alignments (top, bottom, left and right) are possible relationships between adjacent components.

Indentation alignment is a special alignment relationship in which one component is located below another and 
offset slightly to the right.

Anchoring indicators

Anchoring indicators appear when components have snapped into position. They illustrate the alignment and 
relationship among components.

Anchors connecting components to their container or to adjacent components are represented by small semi-
circular indicators with dashed lines.

Visualization of gaps

The gaps between components are visualized as light gray rectangles. Fixed size gaps are solid and resizable gaps 
are shown with springs inside. Adjacent gaps are shown when a component is selected. All gaps between all 
components are shown if a container is selected.

To disable visualization of gaps, right-click on a GroupLayout container and deselect .Show Gaps

Commands

The designer  provides following GroupLayout specific commands:context menu

Command Description

Align in column/row Aligns the selected components left/right/top/bottom/center in column/row.
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Command Description

Align Aligns the selected components left/right/top/bottom.

Anchor Changes the anchoring of the selected components. A component is usually horizontally 
anchored left/right and vertically anchored top/bottom. Anchoring connects a component to a 
container edge or a neighborhood component edge.

Horizontal Auto 
Resizing

Makes the selected components resize horizontally at runtime if the container size changes.

Vertical Auto 
Resizing

Makes the selected components resize vertically at runtime if the container size changes.

Same Width Makes the selected components all the same width. If one of the selected components is 
already in a group of "Same Width" components, the other components are added to the 
existing group. To remove components from a group, select them and then execute this 
command. Grouped components are marked with a small indicator.

Same Height Makes the selected components all the same height. See "Save Width" command for more 
details.

Set to Default Size Makes the selected components have its default size.

Edit Layout Space Changes the gaps around the selected component.

Show Gaps Shows/hides the gaps around the selected components.

Duplicate Duplicates the selected components and places the new components below the original 
components. Use , ,  or  keys to place the duplicated Ctrl+Left Ctrl+Right Ctrl+Up Ctrl+Down
components left, right, above or below the original components.

Layout manager properties

A container with this layout manager has following :layout manager properties

Property Name Description Default

honors visibility Specifies whether component visibility is considered when positioning and sizing 
components. If true, non-visible components are not treated as part of the layout. If 
false, components are positioned and sized regardless of visibility.

true

Layout constraints properties

A component contained in a container with this layout manager has following :layout constraints properties

Property Name Description Default

horizontal size Specifies the component's horizontal size in pixel or Default. If set to Default, the 
component's preferred width is used.

Default

vertical size Specifies the component's vertical size in pixel or Default. If set to Default, the 
component's preferred height is used.

Default

horizontal resizable Specifies whether the component is horizontal resizable. false

vertical resizable Specifies whether the component is vertical resizable. false

top gap Specifies size of the top gap.

left gap Specifies size of the left gap.

bottom gap Specifies size of the bottom gap.

right gap Specifies size of the right gap.

top gap resizable Specifies whether the top gap is vertical resizable. false
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Property Name Description Default

left gap resizable Specifies whether the left gap is horizontal resizable. false

bottom gap resizable Specifies whether the bottom gap is vertical resizable. false

right gap resizable Specifies whether the right gap is horizontal resizable. false
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8.9   HorizontalLayout (SwingX)

The horizontal layout manager places components horizontally. The components are stretched vertically to the 
height of the container. The components will not wrap as in .FlowLayout

Because the , it is not recommended to use this layout manager.SwingX project seems to be discontinued

HorizontalLayout is part of the SwingX open source project and  part of the standard Java distribution. You not
must ship an additional library with your application. The JFormDesigner distribution does not include the 
SwingX library.

Layout manager properties

A container with this layout manager has following :layout manager properties

Property Name Description Default

gap The horizontal gap between components. 0
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8.10   IntelliJ IDEA GridLayout

The IntelliJ IDEA grid layout manager places components in a grid of columns and rows, allowing specified 
components to span multiple columns or rows. Not all columns/rows necessarily have the same width/height.

Note: The IntelliJ IDEA grid layout manager is supported to make it easier to migrate forms, which were created 
with IntelliJ IDEA's GUI builder. If you never used it, it is recommended to use one of the other grid-based layout 
managers.

Use the column and row  to insert or delete columns/rows and change column/row properties. Use headers
horizontal and vertical spacers, which are available in the , to define space between components.Palette

IntelliJ IDEA GridLayout is open source and  part of the standard Java distribution. You must ship an not
additional library with your application. JFormDesigner includes  in its intellij_forms_rt.jar

. For more documentation and tutorials, visit .redistributables www.jetbrains.com/idea/

IDE plug-ins: If you use IntelliJ IDEA GridLayout the first time, the JFormDesigner IDE plug-in ask you whether it 
should copy the required library (and its source code) to the IDE project and add it to the classpath of the IDE 
project.

Layout manager properties

A container with this layout manager has following :layout manager properties

Property Name Description Default

horizontal gap The horizontal gap between components. If -1, then inherits gap from parent 
container that also uses IntelliJ IDEA GridLayout, or uses 10 pixels.

-1

vertical gap The vertical gap between components. If -1, then inherits gap from parent container 
that also uses IntelliJ IDEA GridLayout, or uses 5 pixels.

-1

same size horizontally If true, all columns get the same width. false

same size vertically If true, all rows get the same height. false

margin Size of the margin between the containers border and its contents. 0,0,0,0

Layout constraints properties

A component contained in a container with this layout manager has following :layout constraints properties

Property Name Description Default

grid x Specifies the component's horizontal grid origin (column index). 0

grid y Specifies the component's vertical grid origin (row index). 0

grid width Specifies the component's horizontal grid extend (number of columns). 1

grid height Specifies the component's vertical grid extend (number of rows). 1

fill Specifies how the component fills its cell. Possible values: None, Horizontal, Vertical 
and Both.

None

anchor Specifies how the component is aligned within its cell. Possible values: Center, North, 
North East, East, South East, South, South West, West and North West.

Center

https://www.jetbrains.com/idea/
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Property Name Description Default

indent The indent of the component within its cell. In pixel multiplied by 10. 0

align grid with parent If true, align the grid of nested containers, which use IntelliJ IDEA GridLayout, with the 
grid of this container.

false

horizontal size policy Specifies how the component affects horizontal resizing behavior. Possible values: 
Fixed, Can Shrink, Can Grow, Want Grow and combinations.

Can Shrink 
and Can 
Grow

vertical size policy Specifies how the component affects vertical resizing behavior. Possible values: Fixed, 
Can Shrink, Can Grow, Want Grow and combinations.

Can Shrink 
and Can 
Grow

minimum size The minimum size of the component. -1, -1

preferred size The preferred size of the component. -1, -1

maximum size The maximum size of the component. -1, -1
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8.11   MigLayout

MigLayout is a superbly versatile and powerful layout manager. It is grid-based, but also supports docking and 
grouping.

Use the column and row  to insert or delete columns/rows and change column/row properties.headers

Compared to other layout managers, MigLayout provides following outstanding features:

Default alignment of components in a column/row.

Specification of minimum and maximum column width or row height.

Supports : LogicalPixel, Pixel, Point, Millimeter, Centimeter, Inch, Percent and ScreenPercent. different units
Especially LogicalPixel units are very useful to create layouts that scale with the screen resolution.

Gaps between columns, rows and components.

Flexible .Growing and Shrinking

Column/row grouping.

In-cell Flow allows putting more than one component into a single grid cell.

Docking Components to the edges of the container.

Button Bars and Button Order.

Override minimum, preferred and maximum .component sizes

Visual Bounds improves/fixes layout (especially on macOS).

Baseline support.

MigLayout is open source and  part of the standard Java distribution. You must ship two additional not
libraries with your application. JFormDesigner includes  and  miglayout-swing.jar miglayout-core.jar

in its . For more documentation and tutorials, visit  or redistributables miglayout.com github.com/mikaelgrev
./miglayout

Maven Central: :  :  : groupId com.miglayout artifactId miglayout-swing version 11.4.2

The API documentation is available here:  and doc.formdev.com/miglayout-swing/ doc.formdev.com/miglayout-
.core/

IDE plug-ins: If you use MigLayout the first time, the JFormDesigner IDE plug-in ask you whether it should 
copy the required libraries (and its source code and documentation) to the IDE project and add it to the 
classpath of the IDE project.

https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#different-units
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#gaps
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#growing-and-shrinking
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#in-cell-flow
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#docking-components
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#button-bars-and-button-order
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#component-sizes
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#visual-bounds
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#baseline-support
http://miglayout.com/
https://github.com/mikaelgrev/miglayout
https://github.com/mikaelgrev/miglayout
https://doc.formdev.com/miglayout-swing/
https://doc.formdev.com/miglayout-core/
https://doc.formdev.com/miglayout-core/
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Insets

By default, all MigLayout containers have insets around the grid. This is similar to setting an  on the EmptyBorder

container. You can change the insets in the .Layout manager properties

Default insets (panel): Zero insets:

If you prefer zero insets by default, you can change the default layout constraints in the .MigLayout preferences

In-cell Flow

MigLayout allows you to place more than one component into a single grid cell. This is very useful for radio button 
 and avoids nested containers.groups

Docking Components

MigLayout supports docking components to its edges (similar to ). You can dock more than one BorderLayout
component to one edge. The center is laid out with a grid.

Order: north, west, south, east Order: east, south, west, north

The docked components are laid out based on the component order. Earlier components get more space as you 
can see in the above screenshots. Use drag and drop in the  view to change order of docked components.Structure

To dock a component, first place it somewhere in the grid, then right-click on the component and select one of the 
 items from the context menu.Dock
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Visual Bounds

Some component bounds are larger than their visual bounds (especially on macOS), which gives too large gaps on 
macOS but optimal gaps on other platforms. MigLayout solves this by considering visual padding when computing 
component sizes.

Visual Padding :on Visual Padding :off

Layout manager properties

A container with this layout manager has following :layout manager properties

Property Name Description White Paper Default

Layout Constraints Comma separated list of layout constraints. This is a string 
representation of the options below.

Layout 
Constraints

   Insets Specifies the insets for the container. Use this instead of an 
.EmptyBorder

insets panel

   Gaps Specifies the default gaps between the columns/rows. gap related

   h align The horizontal alignment of the layout within its container. Possible 
values: Default, Left, Center, Right, Leading and Trailing.

alignx Default

   v align The vertical alignment of the layout within its container. Possible 
values: Default, Top, Center and Bottom.

aligny Default

   Fill Specifies whether columns and/or rows should claim all available 
space in the container. Possible values: (none), X, Y and Both.

fill (none)

   Hide Mode Specifies how the layout manager handles invisible components. hidemode 0

   Flow Y If true, multiple components in a single cell are lay out vertically. flowy false

   right-to-left If true, the columns are added from right-to-left. righttoleft false

   bottom-to-top If true, the rows are added from bottom-to-top. bottomtotop false

   Visual Padding If true, padding of  is considered when computing visual bounds
component sizes.

novisualpadding true

Column Constraints Constraints of all columns of the container. This property is for 
experts only. Use the  instead of editing this column header
property.

Column 
Constraints

Row Constraints Constraints of all rows of the container. This property is for experts 
only. Use the  instead of editing this property.row header

Row Constraints

https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#layout-constraints
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#layout-constraints
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#layout_cons_insets
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#layout_cons_gap
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#layout_cons_align
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#layout_cons_align
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#layout_cons_fill
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#layout_cons_hidemode
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#layout_cons_flowy
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#layout_cons_lefttoright
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#layout_cons_toptobottom
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#visual-bounds
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#layout_cons_novisualpadding
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#columnrow-constraints
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#columnrow-constraints
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#columnrow-constraints
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Column/row properties

Each column and row has its own properties. Use the column and row  to change column/row properties.headers

Field Description White 
Paper

Column
/Row

The index of the column/row. Use the 
arrow buttons (or , , Alt+Left Alt+Right

,  keys) to edit the Alt+Up Alt+Down
properties of the previous or next column
/row.

Constraints The column/row constraints. This is a 
string representation of the options below.

Column
/Row 
Constraints

Gap before
/after

The gaps before and after the column/row. BoundSize

Default 
alignment

The default alignment of the components 
within a column/row. Used if the value of 
the component constraint properties "h 
align" or "v align" are set to Default.

align, fill

Size The width of a column or height of a row. 
You can specify preferred, minimum and a 
maximum sizes.

UnitValue, 
BoundSize

Resize 
behavior

The grow/shrink weight and priority of the 
column/row.

grow, 
, growprio

, shrink
shrinkprio

Grouping See  for details.column/row grouping sizegroup

Tip: The column/row context menu allows you to alter many of these options for multi-selections.

Layout constraints properties

A component contained in a container with this layout manager has following :layout constraints properties

Property Name Description White 
Paper

Default

Layout Constraints Comma separated component constraints. Component 
Constraints

Grid Bounds The computed grid cell bounds (read-only).

Cell The component's grid cell origin (column and row indices). cell 0,0

Span The component's grid cell extend (number of columns and rows). span 1,1

h align The horizontal alignment of the component within its cell. Possible 
values: Default, Left, Center, Right, Fill, Leading, Trailing and Label.

alignx Default

v align The vertical alignment of the component within its cell. Possible values: 
Default, Top, Center, Bottom, Fill and Baseline.

aligny Default

Width Overrides the component's minimum, preferred and maximum widths. width, wmin
, wmax

Height Overrides the component's minimum, preferred and maximum heights. height, 
, hmin hmax

Gaps The gaps between the component and the cell edges. Increases cell size. gap 0,0,0,0

Padding The padding between the component and the cell edges. Does not 
increase cell size.

pad 0,0,0,0

https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#columnrow-constraints
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#columnrow-constraints
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#columnrow-constraints
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#boundsize
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#colrow_cons_align
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#colrow_cons_fill
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#unitvalue
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#boundsize
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#colrow_cons_grow
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#colrow_cons_growprio
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#colrow_cons_shrink
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#colrow_cons_shrinkprio
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#colrow_cons_sizegroup
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#component-constraints
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#component-constraints
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#comp_cons_cell
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#comp_cons_span
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#comp_cons_align
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#comp_cons_align
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#comp_cons_size
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#comp_cons_min_max_size
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#comp_cons_min_max_size
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#comp_cons_size
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#comp_cons_min_max_size
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#comp_cons_min_max_size
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#comp_cons_gap
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#comp_cons_pad
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Property Name Description White 
Paper

Default

Dock Dock the component at an edge or the center of the container. Possible 
values: (none), North, South, West, East and Center.

dock (none)

Tag Tag used for platform dependent button ordering. Possible values: 
(none), ok, cancel, help, help2, yes, no, apply, next, back, finish, left, right 
and other.

tag (none)

Tip: The component context menu allows you to alter some constraints for multi-selections.

https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#comp_cons_dock
https://www.formdev.com/jformdesigner/doc/layouts/miglayout-whitepaper/#comp_cons_tag
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8.12   null Layout

null layout is not a real layout manager. It means that no layout manager is assigned and the components can be 
put at specific x,y coordinates.

It is useful for making quick prototypes. But it is not recommended for production because it is not portable. The 
fixed locations and sizes do not change with the environment (e.g. different fonts on various platforms).

Preferred sizes

JFormDesigner supports preferred sizes of child components. This solves one common problem of null layout: the 
component sizes change with the environment (e.g. different fonts on various platforms). Unlike other GUI 
designers, no additional library is required.

Grid

To make it easier to align components, the component edges snap to an invisible grid when moving or resizing 
components. You can specify the grid step size in the  dialog. To temporary disable grid snapping, hold Preferences
down the  key while moving or resizing components.Shift

Keyboard

You can move selected components with  and change size with .Ctrl+ArrowKey Shift+ArrowKey

Aligning components

The align commands help you to align a set of components or make them same width or height.

The dark blue handles in the above screenshot indicate the first selected component.

Command Description

Align Left Line up the left edges of the selected components with the left edge of the first selected component.

Align Center Horizontally line up the centers of the selected components with the center of the first selected 
component.

Align Right Line up the right edges of the selected components with the right edge of the first selected 
component.
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Command Description

Align Top Line up the top edges of the selected components with the top edge of the first selected component.

Align Middle Vertically line up the centers of the selected components with the center of the first selected 
component.

Align Bottom Line up the bottom edges of the selected components with the bottom edge of the first selected 
component.

Same Width Make the selected components all the same width as the first selected component.

Same Height Make the selected components all the same height as the first selected component.

Make Horizontal
Space Equal

Makes the horizontal space between 3 or more selected components equal. The leftmost and 
rightmost components stay unchanged. The other components are horizontally distributed 
between the leftmost and rightmost components.

Make Vertical
Space Equal

Makes the vertical space between 3 or more selected components equal. The topmost and 
bottommost components stay unchanged. The other components are vertically distributed between 
the topmost and bottommost components.

Layout manager properties

A container with this layout manager has following :layout manager properties

Property Name Description Default

auto-size If true, computes the size of the container so that all children are entire visible. If false, 
the size of the container in the Design view is used.

true

Layout constraints properties

A component contained in a container with this layout manager has following :layout constraints properties

Property Name Description Default

x The x coordinate of the component relative to the left corner of the container. 0

y The y coordinate of the component relative to the upper corner of the container. 0

width The width of the component in pixel or Preferred. If set to Preferred, the component's 
preferred width is used.

Preferred

height The height of the component in pixel or Preferred. If set to Preferred, the component's 
preferred width is used.

Preferred



JFormDesigner 8.3 Documentation

- 109 -

8.13   TableLayout

The table layout manager places components in a grid of columns and rows, allowing specified components to 
span multiple columns or rows. Not all columns/rows necessarily have the same width/height.

A column/row can be given an absolute size in pixels, a percentage of the available space, or it can grow and 
shrink to fill the remaining space after other columns/rows have been resized.

Use the column and row  to insert or delete columns/rows and change column/row properties.headers

TableLayout is open source and  part of the standard Java distribution. You must ship an additional library not
with your application. JFormDesigner includes  in its . For more TableLayout.jar redistributables
documentation and tutorials, visit .www.clearthought.info/sun/products/jfc/tsc/articles/tablelayout/

Maven Central: :  :  : groupId tablelayout artifactId TableLayout version 20050920

API documentation: doc.formdev.com/tablelayout/
Source code: github.com/JFormDesigner/swing-tablelayout

IDE plug-ins: If you use TableLayout the first time, the JFormDesigner IDE plug-in ask you whether it should 
copy the required library (and its source code and documentation) to the IDE project and add it to the 
classpath of the IDE project.

Extensions

JFormDesigner extends the original TableLayout with following features:

Default component alignment
Allows you to specify a default alignment for components within columns/rows. This is very useful for 
columns with right aligned labels because you specify the alignment only once for the column and all added 
labels will automatically aligned to the right.

Layout manager properties

A container with this layout manager has following :layout manager properties

Property Name Description Default

horizontal gap The horizontal gap between components. 5

vertical gap The vertical gap between components. 5

http://www.clearthought.info/sun/products/jfc/tsc/articles/tablelayout/
https://doc.formdev.com/tablelayout/
https://github.com/JFormDesigner/swing-tablelayout
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Column/row properties

Each column and row has its own properties. Use the column and row  to change column/row properties.headers

Field Description

Column
/Row

The index of the column/row. Use the arrow buttons (or 
, , ,  keys) to edit the Alt+Left Alt+Right Alt+Up Alt+Down

properties of the previous or next column/row.

Default 
alignment

The default alignment of the components within a column
/row. Used if the value of the constraints properties "h 
align" or "v align" is DEFAULT.

Size Specifies how TableLayout computes the width/height of 
a column/row.

Tip: The column/row context menu allows you to alter many of these options for multi-selections.

Layout constraints properties

A component contained in a container with this layout manager has following :layout constraints properties

Property Name Description Default

grid x Specifies the component's horizontal grid origin (column index). 0

grid y Specifies the component's vertical grid origin (row index). 0

grid width Specifies the component's horizontal grid extend (number of columns). 1

grid height Specifies the component's vertical grid extend (number of rows). 1

h align The horizontal alignment of the component within its cell. Possible values: DEFAULT, 
LEFT, CENTER, RIGHT and FILL.

DEFAULT

v align The vertical alignment of the component within its cell. Possible values: DEFAULT, TOP, 
CENTER, BOTTOM and FILL.

DEFAULT

In contrast to the TableLayoutConstraints API, which uses [column1,row1,column2,row2] to specify the location 
and size of a component, JFormDesigner uses the usual [x,y,width,height] notation.

Tip: The component context menu allows you to alter the alignment for multi-selections.
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8.14   VerticalLayout (SwingX)

The vertical layout manager places components vertically. The components are stretched horizontally to the width 
of the container.

Because the , it is not recommended to use this layout manager.SwingX project seems to be discontinued

VerticalLayout is part of the SwingX open source project and  part of the standard Java distribution. You not
must ship an additional library with your application. The JFormDesigner distribution does not include the 
SwingX library.

Layout manager properties

A container with this layout manager has following :layout manager properties

Property Name Description Default

gap The vertical gap between components. 0
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9   Java Code Generator
JFormDesigner can generate and update Java source code. It uses the same name for the Java file as for the Form 
file. E.g.:

      (form file)C:\MyProject\src\com\myproject\WelcomeDialog.jfd

      (java file)C:\MyProject\src\com\myproject\WelcomeDialog.java

Stand-alone: Before creating new forms, you should specify the locations of your Java  in the source folders Project
dialog. Then JFormDesigner can generate valid  statements. For the above example, you should add package C:

.\MyProject\src

IDE plug-ins: The source folders of the IDE projects are used.

If the Java file does not exist, JFormDesigner generates a new one. Otherwise, it parses the existing Java file and 
inserts/updates the code for the form and adds import statements if necessary.

Stand-alone: The Java file will be updated when saving the form file.

IDE plug-ins: If the Java file is opened in the IDE editor, it will be immediately updated in-memory on each change 
in JFormDesigner. Otherwise, it will be updated when saving the form file.

JFormDesigner uses special comments to identify the code sections that it will generate/update. E.g.:

// JFormDesigner - ... //GEN-BEGIN:initComponents

// JFormDesigner - ... //GEN-END:initComponents

The starting comment must contain , the ending comment . These GEN-BEGIN:<keyword> GEN-END:<keyword>

comments are NetBeans compatible. The text before  and  (in the same line) does not GEN-BEGIN GEN-END

matter. JFormDesigner uses the following keywords:

Keyword name Description

initComponents Used for code that instantiates and initializes the components of the form.

variables Used for code that declares the class level variables for components.

initI18n Used for code that initializes localized component properties if option "Generate 
initComponentsI18n() method" is enabled in the  preferences or Localization (Java Code Generator)

."(form)" properties

initBindings Used for code that initializes bindings if option "Generate initComponentBindings() method" is 
enabled in the  preferences or .Localization (Java Code Generator) "(form)" properties
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9.1   Nested Classes

One of the advanced features of JFormDesigner is the generation of nested classes. Normally, all code for a form is 
generated into one class. If you have forms with many components, e.g. a  with some tabs, it is not JTabbedPane

recommended having only one class. If you hand-code such a form, you would create a class for each tab.

In JFormDesigner you can specify a nested class for each component. You do this in the  category Code Generation
in the  view. JFormDesigner automatically generates/updates the specified nested classes. This allows Properties
you to program more object-oriented and makes your code easier to read and maintain.

   

Components having a nested class are marked with a  overlay symbol in the  view.Structure

Example source code:

public  NestedClassDemoclass

     JPanelextends

{

     NestedClassDemo() {public

        initComponents();

    }

      initComponents() {private void

        // JFormDesigner - Component initialization - DO NOT MODIFY  //GEN-BEGIN:initComponents

        tabbedPane =  JTabbedPane();new

        tab1Panel =  Tab1Panel();new

        tab2Panel =  Tab2Panel();new

        //======== this ========

        setLayout(  BorderLayout());new

        //======== tabbedPane ========

        {

            tabbedPane.addTab( , tab1Panel);"tab 1"

            tabbedPane.addTab( , tab2Panel);"tab 2"

        }

        add(tabbedPane, BorderLayout. );CENTER

        // JFormDesigner - End of component initialization  //GEN-END:initComponents

    }

    // JFormDesigner - Variables declaration - DO NOT MODIFY  //GEN-BEGIN:variables

     JTabbedPane tabbedPane;private

     Tab1Panel tab1Panel;private

     Tab2Panel tab2Panel;private

    // JFormDesigner - End of variables declaration  //GEN-END:variables

    //---- nested class Tab1Panel -----------------------------------------------------

      Tab1Panelprivate class

         JPanelextends

    {

         Tab1Panel() {private

            initComponents();

        }

          initComponents() {private void

            // JFormDesigner - Component initialization - DO NOT MODIFY  //GEN-BEGIN:initComponents

            label2 =  JLabel();new

            textField1 =  JTextField();new

            CellConstraints cc =  CellConstraints();new

            //======== this ========

            setBorder(Borders. );TABBED_DIALOG

            setLayout(  FormLayout( ... ));new
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            //---- label2 ----

            label2.setText( );"text"

            add(label2, cc.xy( , ));1 1

            //---- textField1 ----

            add(textField1, cc.xy( , ));3 1

            // JFormDesigner - End of component initialization  //GEN-END:initComponents

        }

        // JFormDesigner - Variables declaration - DO NOT MODIFY  //GEN-BEGIN:variables

         JLabel label2;private

         JTextField textField1;private

        // JFormDesigner - End of variables declaration  //GEN-END:variables

    }

    //---- nested class Tab2Panel -----------------------------------------------------

      Tab2Panelprivate class

         JPanelextends

    {

         Tab2Panel() {private

            initComponents();

        }

          initComponents() {private void

            // JFormDesigner - Component initialization - DO NOT MODIFY  //GEN-BEGIN:initComponents

            label3 =  JLabel();new

            checkBox1 =  JCheckBox();new

            CellConstraints cc =  CellConstraints();new

            //======== this ========

            setBorder(Borders. );TABBED_DIALOG

            setLayout(  FormLayout( ... ));new

            //---- label3 ----

            label3.setText( );"text"

            add(label3, cc.xy( , ));1 1

            //---- checkBox1 ----

            checkBox1.setText( );"text"

            add(checkBox1, cc.xy( , ));3 1

            // JFormDesigner - End of component initialization  //GEN-END:initComponents

        }

        // JFormDesigner - Variables declaration - DO NOT MODIFY  //GEN-BEGIN:variables

         JLabel label3;private

         JCheckBox checkBox1;private

        // JFormDesigner - End of variables declaration  //GEN-END:variables

    }

}

When changing the nested class name in the  category, JFormDesigner also renames the nested Code Generation
class in the Java source code. When removing the nested class name, then JFormDesigner does not remove the 
nested class in the Java source code to avoid loss of own source code.
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9.2   Code Templates

When generating new Java files or classes, JFormDesigner uses the templates specified in the  dialog.Preferences

Template name Description

File header Used when creating new Java files. Contains a header comment and a  statement.package

Class Used when generating a new (nested) class. Contains a class declaration, a constructor, a component 
initialization method and variable declarations.

Empty Class Used when generating a new empty class. This can happen, if all form components are contained in 
nested classes.

Event Handler Body Used for event handler method bodies.

Component 
Initialization

Replaces the variable  used in other templates. Contains a ${component_initialization}

method named . Invoke this method from your code to instantiate the initComponents

components of your form. Feel free to change the method name if you don't like it.

Component I18n 
Initialization

Used for code that initializes localized component properties if option "Generate 
initComponentsI18n() method" is enabled in the  preferences or Localization (Java Code Generator)

."(form)" properties

Component Binding 
Initialization

Used for code that initializes bindings if option "Generate initComponentBindings() method" is 
enabled in the  preferences or .Localization (Java Code Generator) "(form)" properties

Variables Declaration Replaces the variable  used in other templates.${variables_declaration}

java.awt.Dialog Used for classes derived from . Compared to the "Class" template, this has java.awt.Dialog

special constructors, which are necessary for  derived classes.java.awt.Dialog

java.awt.Frame Used for classes derived from . Equal to the "Class" template, but necessary java.awt.Frame

because  extends , which has its own template and a java.awt.Frame java.awt.Window

constructor that is not compatible with .java.awt.Frame

java.awt.Window Used for classes derived from . Compared to the "Class" template, this has a java.awt.Window

special constructor, which are necessary for  derived classes.java.awt.Window

javax.swing.
AbstractAction

Used for nested action classes.

Property: Icon from 
resource

Used for bitmap icons.

Property: SVG Icon 
from resource

Used for SVG icons.

You can change the existing templates or create additional templates in the  dialog. It is possible to Preferences
define your own templates for specific superclasses.

Following variables can be used in the templates:

Variable name Description Context

${date} Current date. global

${user} User name. global

${package_declaration} package  statement. If the form is not saved under one of the  source folders
specified in the  dialog, the variable is empty (no  statement will be Project package

generated).

file header

${class_name} Name of the (nested) class. class

${component_initialization} See template "Component initialization". class

${constructor_modifiers} Modifiers of the constructor. Based on the class modifiers. class

${extends_declaration} The  declaration of the class; empty if the class has no superclass.extends class

${modifiers} Modifiers of the (nested) class. You can specify the default modifiers in the 
 dialog.Preferences

class
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Variable name Description Context

${variables_declaration} See template "Variables declaration". class
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10   Command Line Tool
The command-line tool allows you to run some commands (e.g. Java code generation) on many forms.

Available commands

Java Code Generation: Usually its not necessary to run the  from command-line because Java code generator
the Java code is automatically generated and updated while editing a form in JFormDesigner. However, in 
rare cases it is useful to re-generate the Java code of JFormDesigner forms. E.g. if you want upgrade to 
JGoodies  1.2 (or later), which introduced a new much shorter syntax for encoded column and FormLayout
row specifications.

Externalize strings: If you have to  many existing non-localized forms, then this command does the localize
job very quickly.

Convert layout manager: Allows you to convert all usages of one layout manager to another one. Useful for 
migrating forms to a modern powerful layout manager (e.g. ).MigLayout

Convert .jfd file format: Since version 5.1, JFormDesigner supports the compact, easy-to-merge and fast-to-
load persistence format JFDML. This command allows you to convert all your .jfd files from XML to JFDML and 
benefit from the new format.

Requirements

You need an installation of the JFormDesigner . If you usually use one of the IDE plug-ins, stand-alone edition
then simply download the stand-alone edition and install it.

Preferences

To specify  for the command-line tool, you should create a stand-alone edition , enable and set preferences project
project specific settings and pass the project .jfdproj file to the command-line tool.

If you usually use the JFormDesigner stand-alone edition and already have a .jfdproj file, then you can use it for the 
command-line tool. Otherwise, start the JFormDesigner stand-alone edition and create a new .project

If you don't use a project, then the command-line tool uses the  store of the stand-alone edition. If you preferences
use one of the IDE plug-ins of JFormDesigner, you have to start the stand-alone edition and set the necessary 
preferences. To transfer JFormDesigner preferences from an IDE to the stand-alone edition, you can use the 

 and  buttons in the Preferences dialogs. Make sure that the  preferences are correct Import Export Code Style
because they are not transferred from the IDE.

Command Line Syntax

Launch the command-line tool as follows, where [ ] means optional arguments and arguments in  must be italics
provided by you.

java -classpath <jfd-install>/lib/JFormDesigner.jar

    com.jformdesigner.application.CommandLineMain

    [--generate|--i18n-externalize|--convert-layout|--convert-jfd]

    [--dry-run] [--verbose|-v] [--recursive|-r]

    [<command-specific-options>]

    [<project-path>/MyProject.jfdproj]

    <folder> or <path>/MyForm1.jfd

[...]

Option Description

-classpath /lib<jfd-install>
/JFormDesigner.jar

Specifies the JAR that contains the command-line tool. This is a standard argument 
of the .Java application launcher

com.jformdesigner.application.
CommandLineMain

The class name of the command-line tool.

https://docs.oracle.com/en/java/javase/25/tools/java.html
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Option Description

--generate Generate Java code for the given forms or folders.

--i18n-externalize Externalize strings in the given forms or folders. This requires that you've specified 
 in the used project.Source Folders

--convert-layout Convert one layout manager to another one.

--convert-jfd Convert the given .jfd files to another format.

--dry-run Execute the given command, but do not save modifications. Only shows what would 
happen. This option enables --verbose.

--verbose or -v Prints file names of processed .jfd and .java files to the console.

--recursive or -r Recursively process folders.

--bundle-name=<bundleName> Only used for --i18n-externalize.
The  used to store strings. You can use variables {package} resource bundle name
(package name of form) and {basename} (basename of form). Default is "{package}.
Bundle", which creates Bundle.properties in same package as the form. This option 
is ignored when processing already localized forms.

--key-prefix=<keyPrefix> Only used for --i18n-externalize.
The . You can use variable {basename} (basename of form). prefix for generated key
Default is "{basename}". This option is ignored when processing already localized 
forms.

--auto-externalize=<true|false> Only used for --i18n-externalize.
Set the  option in the processed forms. Default is true.auto-externalize

--old-layout=<layoutClassName> Only used for --convert-layout.
The full qualified class name of the layout manager that will be converted to another 
layout manager.

--new-layout=<layoutClassName> Only used for --convert-layout.
The full qualified class name of the target layout manager.

--lookandfeel=<lookAndFeelClassName> Only used for --convert-layout.
The full qualified class name of a look and feel that will be used for layout manager 
conversion. This is useful if the old layout manager uses units that depend on the 
look and feel (e.g. FormLayout dialog units). Default is the system look and feel.

--format=<JFDML|XML> Only used for --convert-jfd.
The target format into which the .jfd files will be converted. Default is "JFDML".

--encoding=<encoding> Only used for --convert-jfd.
The encoding used to store JFDML content. See  for java.nio.charset.Charset
supported encodings. Defaults is "UTF-8".

--header-comment=<headerComment> Only used for --convert-jfd.
A comment that is stored in the header of the converted .jfd files. May contain "\n", 
which is converted to real newline character.

<project-path>/MyProject.jfdproj Optional JFormDesigner stand-alone edition  used to extend the classpath project
and to specify other . Useful when using custom components.preferences

<folder> or  [...]<path>/MyForm1.jfd List of folders or .jfd files. If a folder is specified, all .jfd files in the folder are 
processed.

The options and parameters are processed in the order they are passed. An option is always used for subsequent 
parameters, but not for preceding ones. E.g. " " processes  recursively, but not src1 --recursive src2 src2

. It is also possible to specify options or projects more than once. E.g. "src1 project1.jfdproj src1 

" uses  for  and  for .project2.jfdproj src2 project1.jfdproj src1 project2.jfdproj src2

https://docs.oracle.com/en/java/javase/25/docs/api/java.base/java/nio/charset/Charset.html
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Using custom components

If you're using custom components (JavaBeans) in your forms, it is necessary to tell the command-line tool the 
classpath of your components, because e.g the code generator needs to load the classes of custom components. 
There are two options to specify the classpath for your custom components:

JFormDesigner stand-alone edition : The JARs and folders specified on the  page in the project Classpath
project settings are used by the command-line tool. This is the preferred way is you use the stand-alone 
edition.

Classpath of : Simply add your JARs to the -classpath option of the Java application Java application launcher
launcher. This is the preferred way if you use Ant (see below).

Examples

Generate code for a single form:

cd C:\MyProject

java -classpath C:\ProgramFiles\JFormDesigner\lib\JFormDesigner.jar

    com.jformdesigner.application.CommandLineMain

    --generate src/com/myproject/MyForm1.jfd

Generate code for all forms in a project that use custom components:

cd C:\MyProject

java -classpath C:\ProgramFiles\JFormDesigner\lib\JFormDesigner.jar;classes;swingx.jar

    com.jformdesigner.application.CommandLineMain

    --generate --recursive src

Externalize strings in all forms of the  folder and use one bundle file per form and no key prefix:src

cd C:\MyProject

java -classpath C:\ProgramFiles\JFormDesigner\lib\JFormDesigner.jar

    com.jformdesigner.application.CommandLineMain

    --i18n-externalize --recursive

    --bundle-name={package}.{basename} --key-prefix=

    MyProject.jfdproj src

Convert all usages for FormLayout to MigLayout in all forms of the  folder:src

cd C:\MyProject

java -classpath C:\ProgramFiles\JFormDesigner\lib\JFormDesigner.jar

    com.jformdesigner.application.CommandLineMain

    --convert-layout

    --old-layout=com.jgoodies.forms.layout.FormLayout

    --new-layout=net.miginfocom.swing.MigLayout

    --lookandfeel=com.sun.java.swing.plaf.windows.WindowsLookAndFeel

    --recursive

    MyProject.jfdproj src

https://docs.oracle.com/en/java/javase/25/tools/java.html
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Ant

Although we don't provide a special task for , it is easy to invoke the JFormDesigner command-line tool from an Ant
Ant script. The <classpath> element makes it easy to specify JARs and folders of custom components.

<property name=  value= />"jfd-install-dir" "C:/Program Files/JFormDesigner"

 classname=<java "com.jformdesigner.application.CommandLineMain"

        fork=  failonerror=  logError= >"true" "true" "true"

    ><classpath

         location= /><pathelement "${jfd-install-dir}/lib/JFormDesigner.jar"

         location= /><pathelement "myLibrary.jar"

    ></classpath

     value= /><arg "--generate"

     value= /><arg "--recursive"

     value= /><arg "src"

></java

https://ant.apache.org/
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11   Runtime Library

Note: If you use the Java code generator, you don't need this library.

The open-source (BSD license) runtime library allows you to load JFormDesigner .jfd files at runtime within your 
applications. Turn off the Java code generation in the  dialog or in the  settings if you use this Preferences Project
library.

You'll find the library  in the  of the JFormDesigner installation; the source jfd-loader.jar redistributables
code is in  and the documentation is in .jfd-loader-sources.jar jfd-loader-javadoc.jar

Maven Central: :  :  : groupId com.formdev.jformdesigner artifactId jfd-loader version 8.3

The API documentation is also available here: .doc.formdev.com/jfd-loader/

Classes

FormLoader  provides methods to load JFormDesigner .jfd files into in-memory form models.

FormCreator  creates instances of Swing components from in-memory form models and provides methods 
to access components.

FormSaver  saves in-memory form models to JFormDesigner .jfd files. Can be used to convert proprietary 
form specifications to JFormDesigner .jfd files: first create an in-memory form model from your form 
specification, then save the model to a .jfd file.

Example

The following example demonstrates the usage of FormLoader and FormCreator. It is included in the  examples
distributed with all JFormDesigner editions.

public  LoaderExampleclass

{

     JDialog dialog;private

       main(String[] args) {public static void

         LoaderExample();new

    }

    LoaderExample() {

         {try

            // load the .jfd file into memory

            FormModel formModel = FormLoader.load(

                );"com/jformdesigner/examples/LoaderExample.jfd"

            // create a dialog

            FormCreator formCreator =  FormCreator(formModel);new

            formCreator.setTarget( );this

            dialog = formCreator.createDialog( );null

            // get references to components

            JTextField nameField = formCreator.getTextField( );"nameField"

            JCheckBox checkBox = formCreator.getCheckBox( );"checkBox"

            // set values

            nameField.setText( );"enter name here"

            checkBox.setSelected( );true

            // show dialog

            dialog.setModal( );true

            dialog.pack();

            dialog.show();

            System.out.println(nameField.getText());

            System.out.println(checkBox.isSelected());

            System.exit( );0

        } (Exception ex) {catch

            ex.printStackTrace();

https://doc.formdev.com/jfd-loader/
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        }

    }

    // event handler for checkBox

      checkBoxActionPerformed(ActionEvent e) {private void

        JOptionPane.showMessageDialog(dialog, );"check box clicked"

    }

    // event handler for okButton

      okButtonActionPerformed() {private void

        dialog.dispose();

    }

}
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12   JavaBeans
What is a Java Bean?

A Java Bean is a reusable software component that can be manipulated visually in a builder tool.

JavaBean (components) are self-contained, reusable software units that can be visually composed into composite 
components and applications. A bean is a Java class that:

is public and not abstract

has a public "null" constructor (without parameters)

has properties defined by public getter and setter methods.

JFormDesigner supports:

Visual beans (must inherit from ).java.awt.Component

Non-visual beans.

BeanInfo

JFormDesigner supports/uses following classes/interfaces specified in the  package:java.beans

BeanInfo

BeanDescriptor

EventSetDescriptor

PropertyDescriptor

PropertyEditor (incl. support for custom and paintable editors)

Customizer

If you are writing BeanInfo classes for your custom components, you can specify additional information needed by 
JFormDesigner using the  extension mechanism.java.beans.FeatureDescriptor

You can also use  to specify these attributes without the pain of implementing BeanInfo BeanInfo Annotations
classes.

For examples using BeanInfo Annotations, example implementations of BeanInfo classes and PropertyEditors, 
take a look at the .examples

BeanDescriptor Attributes

Following attributes are supported in :BeanDescriptor

Attribute Name Description

isContainer Specifies whether a component is a container or not. A container can have child components. The value 
must be a . Default is false. E.g.Boolean

beanDesc.setValue( , . );"isContainer" Boolean TRUE

containerDelegate If components should be added to a descendant of a container, then it is possible to specify a method 
that returns the container for the children.  is an example for such a JFrame.getContentPane()

method. The value must be a  and specifies the name of a method that takes no arguments and String

returns a . E.g.java.awt.Container

beanDesc.setValue( , );"containerDelegate" "getContentPane"

layoutManager

https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/package-summary.html
https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/BeanInfo.html
https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/BeanDescriptor.html
https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/EventSetDescriptor.html
https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/PropertyDescriptor.html
https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/PropertyEditor.html
https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/Customizer.html
https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/FeatureDescriptor.html
https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/BeanDescriptor.html
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Attribute Name Description

Allows the specification of a layout manager, which is used when adding the component to a form. If 
specified, then JFormDesigner does not allow the selection of a layout manager. The value must be a 

. E.g.Class

beanDesc.setValue( , BorderLayout. );"layoutManager" class

persistenceDelegate Specifies an instance of a class, which extends , that can be used java.beans.PersistenceDelegate

to persist an instance of the bean. E.g.

beanDesc.setValue( ,  MyBeanPersistenceDelegate());"persistenceDelegate" new

PropertyDescriptor Attributes

Following attributes are supported in :PropertyDescriptor

Attribute Name Description

category Specifies the property category to which the property belongs. JFormDesigner adds the specified 
category to the  view. The value must be a .Properties String

propDesc.setValue( , );"category" "My Properties"

enumerationValues Specifies a list of valid property values. The value must be an . For each property value, Object[]

the  must contain three items:Object[]

Name: A displayable name for the property value.

Value: The actual property value.

Java Initialization String: A Java code piece used when generating code.

propDesc.setValue( ,  Object[] {"enumerationValues" new

    , JSlider. , ,"horizontal" HORIZONTAL "JSlider.HORIZONTAL"

    ,   JSlider. ,   ,"vertical" VERTICAL "JSlider.VERTICAL"

});

extraPersistenceDelegates Specifies a list of persistence delegates for classes. The value must be an . For each Object[]

class, the  must contain two items:Object[]

Class: The class for which the persistence delegate should be used.

Persistence delegate: Instance of a class, which extends java.beans.

, that should be used to persist an instance of the specified class.PersistenceDelegate

Use the attribute "persistenceDelegate" (see below) to specify a persistence delegate for the 
property value. Use this attribute to specify persistence delegates for classes that are referenced 
by the property value. E.g. if a property value references classes MyClass1 and MyClass2:

propDesc.setValue( ,  Object[] {"extraPersistenceDelegates" new

    MyClass1. ,  MyClass1PersistenceDelegate(),class new

    MyClass2. ,  MyClass2PersistenceDelegate(),class new

});

imports Specifies one or more class names for which import statements should be generated by the Java 
code generator. This is useful if you don't use full qualified class names in  enumerationValues

or . The value must be a  or PropertyEditor.getJavaInitializationString() String

. E.g.String[]

propDesc.setValue( , );"imports" "com.mycompany.MyConstants"

propDesc.setValue( ,  String[] {"imports" new

    ,"com.mycompany.MyConstants"

    ,"com.mycompany.MyExtendedConstants"

});

notMultiSelection Specifies whether the property is not shown in the  view when multiple components are Properties
selected. The value must be a . Default is false. E.g.Boolean

propDesc.setValue( , . );"notMultiSelection" Boolean TRUE

notNull

https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/PropertyDescriptor.html
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1.  

2.  

Attribute Name Description

Specifies that a property can not set to  in the  view. If true, the  null Properties Set Value to null
command is disabled. The value must be a . Default is false. E.g.Boolean

propDesc.setValue( , . );"notNull" Boolean TRUE

notRestoreDefault Specifies that a property value can not restored to the default in the  view. If true, the Properties
 command is disabled. The value must be a . Default is false. E.g.Restore Default Value Boolean

propDesc.setValue( , . );"notRestoreDefault" Boolean TRUE

persistenceDelegate Specifies an instance of a class, which extends , that can be java.beans.PersistenceDelegate

used to persist an instance of a property value. E.g.

propDesc.setValue( ,  MyPropPersistenceDelegate());"persistenceDelegate" new

preferredBinding Specifies that a property is a preferred binding property. If true, the property is added to the  Bind
submenu (right-click on component) and highlighted in bold in the  dialog. The value must Binding
be a . Default is false. E.g.Boolean

propDesc.setValue( , . );"preferredBinding" Boolean TRUE

readOnly Specifies that a property is read-only in the  view. The value must be a . Properties Boolean

Default is false. E.g.

propDesc.setValue( , . );"readOnly" Boolean TRUE

transient Specifies that the property value should not persisted and no code should generated. The value 
must be a . Default is false. E.g.Boolean

propDesc.setValue( , . );"transient" Boolean TRUE

variableDefault Specifies whether the default property value depends on other property values. The value must be 
a . Default is false. E.g.Boolean

propDesc.setValue( , . );"variableDefault" Boolean TRUE

Design time

JavaBeans support the concept of "design"-mode, when JavaBeans are used in a GUI design tool, and "run"-mode, 
when JavaBeans are used in an application.

You can use the method  in your JavaBean to determine whether it is java.beans.Beans.isDesignTime()

running in JFormDesigner or in your application.

Reload beans

JFormDesigner automatically reloads classes of custom JavaBeans when changed. So you can change the source 
code of used custom JavaBeans, compile them in your IDE and use them in JFormDesigner immediately without 
restarting.

You can also manually reload classes:

Stand-alone: Select  from the menu or press .View > Refresh Designer F5

IDE plug-ins: Click the  button ( ) in the designer tool bar.Refresh Designer

Refresh does following:

Create a new class loader for loading JavaBeans, BeanInfos and Icons.

Recreates the form in the active  view.Design

Unsupported standard components

all AWT components
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13   Annotations
The  and  annotations make it very easy to specifying BeanInfo information directly @BeanInfo @PropertyDesc

in the custom component. It is no longer necessary to implement extra BeanInfo classes. This drastically reduces 
time and code needed to create BeanInfo information.

When using the JFormDesigner annotations, you have to add the library  (from jfd-annotations.jar

) to the build path of your project (necessary for the Java compiler). The source code is in redistributables jfd-

 and the documentation is in . It is  annotations-sources.jar jfd-annotations-javadoc.jar not
necessary to distribute  with your application.jfd-annotations.jar

Maven Central: :  :  : groupId com.formdev.jformdesigner artifactId jfd-annotations version 1.0

The API documentation is also available here: doc.formdev.com/jfd-annotations/

@BeanInfo

This annotation can be used to specify additional information for constructing a  class and its BeanInfo
.BeanDescriptor

Example for specifying a description, an icon, property display names and flags, and property categories:

@BeanInfo(

    description= ,"My Bean"

    icon= ,"MyBean.gif"

    properties={

        (name= , displayName= , preferred= )@PropertyDesc "magnitude" "magnitude (in %)" true

        (name= , expert= )@PropertyDesc "enabled" true

    },

    categories={

        (name= , properties={ , , }),@Category "Sizes" "preferredSize" "minimumSize" "maximumSize"

        (name= , properties={ , }),@Category "Colors" "background" "foreground"

    }

)

  MyBean  JCompoment { ... }public class extends

Example for a container component that has a content pane:

@BeanInfo(isContainer= , containerDelegate= )true "getContentPane"

  MyPanel  JPanel { ... }public class extends

@PropertyDesc

This annotation can be used to specify additional information for constructing a .PropertyDescriptor

This annotation may be used in a  annotation (see ) or may be attached @BeanInfo @BeanInfo.properties()

to property getter or setter methods. If the getter method of a property is annotated, then the setter method of 
the same property is not checked for this annotation.

Important: This annotation requires that the  annotation is specified for the bean class. Otherwise, @BeanInfo

this annotation is ignored when specified at methods.

Example for attaching this annotation to a property getter method:

@PropertyDesc(displayName= , preferred= )"magnitude (in %)" true

  getMagnitude() {public int

     magnitude;return

}

https://doc.formdev.com/jfd-annotations/
https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/BeanInfo.html
https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/BeanDescriptor.html
https://docs.oracle.com/en/java/javase/25/docs/api/java.desktop/java/beans/PropertyDescriptor.html
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Example for specifying this annotation in a  annotation:@BeanInfo

@BeanInfo(

    properties={

        (name= , displayName= , preferred= )@PropertyDesc "magnitude" "magnitude (in %)" true

    }

)

  MyBean  JCompoment { ... }public class extends

@DesignCreate

This annotation can be used to mark a static method that should be invoked by JFormDesigner to create instances 
of the bean, which are then used in the JFormDesigner  view. The annotated method must be static, must Design
not have parameters and must return the instance of created bean.

Example for using this annotation to initialize the bean with test data for the Design view:

public  MyBean  JCompoment {class extends

    @DesignCreate

      MyBean designCreate() {private static

        MyBean myBean =  MyBean();new

        myBean.setData(  SomeDummyDataForDesigning() );new

         myBean;return

    }

     MyBean() {public

        // ...

    }

}
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14   JGoodies Forms
JFormDesigner supports and uses software provided by  Karsten Lentzsch.JGoodies

The  framework support is very extensive. Not only the layout manager  is supported, JGoodies Forms FormLayout
also some important helper classes are supported: ,  and  (was Borders ComponentFactory FormSpecs

).FormFactory

JGoodies Forms ComponentFactory

The JGoodies Forms ComponentFactory (com.jgoodies.forms.factories) defines three factory methods, which 
create components. You find these components in the palette category JGoodies.

Label : A label with an optional mnemonic. The mnemonic and mnemonic index are defined by a single 
ampersand (&). For example "&Save" or "Save &As". To use the ampersand itself duplicate it, for example 
"Look&&Feel".

Title : A label that uses the foreground color and font of a  with an optional mnemonic. TitledBorder

The mnemonic and mnemonic index are defined by a single ampersand (&).

Titled Separator : A labeled separator. Useful to separate paragraphs in a panel, which is often a better 
choice than a .TitledBorder

http://www.jgoodies.com/
https://doc.formdev.com/jgoodies-forms/com/jgoodies/forms/factories/Borders.html
https://doc.formdev.com/jgoodies-forms/com/jgoodies/forms/factories/ComponentFactory.html
https://doc.formdev.com/jgoodies-forms/com/jgoodies/forms/layout/FormSpecs.html
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15   Examples & Redistributables
A JFormDesigner installation includes example source code and redistributable files. Because JFormDesigner is 
available in several editions and each IDE plug-in has its own requirements regarding plug-in directory structure 
and installation location, the installation location of the examples and redistributables depends on the 
JFormDesigner edition. The tables below list the locations for each JFormDesigner edition.

Examples

The  archive contains example source code and forms. See included  for details.examples.zip README.html

Edition Location

Stand-alone <jformdesigner-install>/examples.zip

macOS:  (right-click on JFormDesigner application and <JFormDesigner.app>/examples.zip

select "Show Package Contents" from the context menu to see contents of <JFormDesigner.app>)

Eclipse plug-in <eclipse-install>/features/com.jformdesigner_x.x.x/examples.zip  or <eclipse-
install>/dropins/JFormDesigner-x.x-eclipse/features/ com.jformdesigner_x.x.x

/examples.zip

IntelliJ IDEA plug-in <user-home>/.IdeaIC<version>/config/plugins/JFormDesigner/examples.zip  or 
<intellij-idea-install>/plugins/JFormDesigner/examples.zip

macOS: <user-home>/Library/Application Support/IdeaIC<version>/JFormDesigner
/examples.zip

NetBeans plug-in <netbeans-install>/jformdesigner/examples.zip

macOS:  <NetBeans.app>/Contents/Resources/NetBeans/jformdesigner/examples.zip

(right-click on NetBeans application and select "Show Package Contents" from the context menu to 
see contents of <NetBeans.app>)

Redistributables

The  folder contains the JFormDesigner , the JFormDesigner  and 3rd redist Annotations Library Runtime Library
party open source files (layout manager, beans binding, etc). See  for information about redist/README.html

licenses.

Edition Location

Stand-alone <jformdesigner-install>/redist/

macOS:  (right-click on JFormDesigner application and select <JFormDesigner.app>/redist/

"Show Package Contents" from the context menu to see contents of <JFormDesigner.app>)

Eclipse plug-in <eclipse-install>/plugins/com.jformdesigner.redist_x.x.x/  or <eclipse-install>
/dropins/JFormDesigner-x.x-eclipse/plugins/ com.jformdesigner.redist_x.x.x/

IntelliJ IDEA plug-in <user-home>/.IdeaIC<version>/config/plugins/JFormDesigner/redist/  or 
<intellij-idea-install>/plugins/JFormDesigner/redist/

macOS: <user-home>/Library/Application Support/IdeaIC<version>/JFormDesigner
/redist/

NetBeans plug-in <netbeans-install>/jformdesigner/redist/

macOS:  (right-<NetBeans.app>/Contents/Resources/NetBeans/jformdesigner/redist/

click on NetBeans application and select "Show Package Contents" from the context menu to see 
contents of <NetBeans.app>)
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